## Table of Contents

**BigPicture Overview** ........................................................................................................... 5
- What is BigPicture? ........................................................................................................ 5
- How do I get it? Is it free? ................................................................................................. 9
- What languages are supported? ....................................................................................... 10
- What are the advantages for using BigPicture over Native Excel for Mapping? .......... 12
- What platforms are supported? ....................................................................................... 19
- BigPicture Documentation ............................................................................................. 20

**What's New in BigPicture?** ................................................................................................. 21
- February 2016 Release ........................................................................................................ 21

**Example Spreadsheets and Videos** .................................................................................... 29
- Are example maps available? .......................................................................................... 29
- Are videos available? ........................................................................................................ 31

**Map Basics** .......................................................................................................................... 32
- How do I start a new map? ............................................................................................... 32
- Can I create several topics all at once? ........................................................................... 35
- How do I create connections between topics? ............................................................... 42
- What are the red squares and circles on topics? ............................................................. 44
- How do I enter or modify a topic label? .......................................................................... 45
- How do I link a topic label to a range? ............................................................................ 48
- How do I add pictures to topics? ..................................................................................... 55
- How do I use Undo? ........................................................................................................... 63
- How do I Convert Excel Shapes to BigPicture Topics .................................................... 65

**Topic Pane and Outline Pane** .............................................................................................. 67
- What is the Topic pane, and why would I use it? ............................................................. 67
- What is the Outline Pane, and how do I use it? .............................................................. 77

**Tools for Modifying Maps** ................................................................................................ 98
- What is Auto Arrange, and when should I use it? ......................................................... 98
- What is the Single Expand option, and when should I use it? ..................................... 102
- How do I format several topics the same way? .............................................................. 107
- Why would I use connector labels, and how do I create them? ..................................... 111
- How do I change the default topic or connector shape to use in all my maps? ............. 119
- How do I utilize conditional formatting with linked cells? .......................................... 129
- How do I connect multiple topics to an additional parent topic? ............................... 135
How do I change the direction of a connector? ................................................................. 140
How do I add Boundaries around my topics? ..................................................................... 142
How do I attach Custom Shapes? ...................................................................................... 146

Selecting and Moving Maps ................................................................. 148
What are the Select options, and why do I need them? .................................................. 148
How do I move an entire map? .......................................................................................... 154
Moving and Reconnecting Topics .................................................................................... 156
What are the expand and collapse buttons? ..................................................................... 158

Notes, Markers and Tags ................................................................................. 159
What are notes, and how do I create them? ..................................................................... 159
What are markers, and how do I create them? ................................................................. 166
How do I change markers to pictures? ............................................................................. 174
What are tags, and how do I use them? ............................................................................ 177

Slide Shows ........................................................................................................... 189
How do I create a slide show? ......................................................................................... 189

Data Maps ........................................................................................................... 202
What is a Data Map and how do I create a Data Map? .................................................... 202
End Topics in Data Maps .............................................................................................. 214
What is a Data Map Report? .......................................................................................... 223
What are Data Map Report defaults? .............................................................................. 228
What are rollup calculations? ......................................................................................... 231

Linked Maps ......................................................................................................... 241
What is a Linked Map and how do I create a Linked Map? ............................................. 241
What is a Linked Map Report? ....................................................................................... 256
Tell me more about possible calculations in a Linked Map ............................................ 259

Org Charts ............................................................................................................ 264
How do I create an Org Chart? ..................................................................................... 264
Tell me more about possible calculations in an Org Chart ............................................ 279
What is an Org Chart Report? ........................................................................................ 286

Import/Export Options ....................................................................................... 290
Can I save a map as a pdf file? ...................................................................................... 290
How do I import MindManager or FreeMind maps into BigPicture? .............................. 294

PrecisionTree Integration ................................................................................... 302
PrecisionTree Feature: View in BigPicture ..................................................................... 302
BigPicture Overview

What is BigPicture?

BigPicture is a diagramming software add-in for Microsoft Excel. With BigPicture, you can create mind maps to organize thoughts and ideas, or create dynamic maps from any type of spreadsheet data. BigPicture takes advantage of the fact that we humans are visual animals—mind maps and diagrams can help us grasp complicated information at a glance. Yet so much of the work we do relies on spreadsheets and data. BigPicture helps combine the power of both visuals and spreadsheets—all right in Excel. Learn more by visiting our BigPicture product page on our Palisade website.

A tool for Brainstorming, Mind Mapping and Strategic Planning

BigPicture allows you to translate your brainstorming process into a dynamic map of ideas and options that are easy to view and update. Create your mind maps with or without data—the process can be as free-form, or as detailed, as you need it to be.
A tool for creating Organizational Charts

Create organizational charts easily: convert salaries, titles, even performance notes—and automatically build a flexible chart that illustrates your organization’s hierarchy, complete with customizable colors, pictures and icons. Expand branches to get a better view of departments and details, or collapse them to get a snapshot of your company as a whole. Any updates you make to your source HR data set are seamlessly incorporated throughout the entire chart.
A tool for Data Exploration

Complex data tables are automatically converted into easy-to-read data maps and infographics. Expand or collapse your data maps at any node to explore or summarize as needed. Plus, all BigPicture data maps are linked to their source data, so updates and restructuring of data maps can be done in seconds.
A Tool for Presenting your Results to Others

Use the slide-show tool for eye-catching, annotated presentations. You can also share your BigPicture diagrams easily by sending your colleagues the standard .xls or .xlsx file or you can export your maps as pdf's.
How do I get it? Is it free?

BigPicture is available as a free 15-day trial [download]. If you decide to purchase after you have downloaded and installed the trial, you will be given a serial number and an Activation ID to convert it to a fully functioning product.

Available as a 15-day Free Download

Simply fill out the form on the BigPicture product page to obtain the installer. After your trial has expired you will be able to still activate the software by purchasing a license. You can purchase directly from our website at [www.palisade.com/BigPicture](http://www.palisade.com/BigPicture). If you have any questions, comments or concerns feel free to send an email to bigpicture@palisade.com.

How do I send Feedback?

We are always looking for ways to improve our products. If you have a suggestion of how we can improve BigPicture, we encourage you to send feedback via an email to bigpicture@palisade.com.
What languages are supported?

We are actively looking for feedback regarding any of the translated terms in our product. If you have a suggestion for a better translation, feel free to submit it to bigpicture@palisade.com. ~Thank you!

BigPicture is available in 8 different languages.

In addition to English, BigPicture's software interface, including all menus, commands and dialogs, have been translated into the following languages:

- Chinese
- French
- German
- Japanese
- Portuguese
- Russian
- Spanish

To toggle to a different language:

- Click on the Utilities icon in the BigPicture ribbon and select Application Settings. (See #1 in image below.)

- Choose the language of your choice via the drop down menu (#2), then click OK.

NOTE: A variety of example files have been translated. Other supporting material will be included in a future build of BigPicture.
Localized Example Files

You can explore a variety of BigPicture's example files that have been translated into French, German, Russian, Spanish, Portuguese, Chinese and Japanese.
What are the advantages for using BigPicture over Native Excel for Mapping?

This is an important question because BigPicture uses Excel shapes and connectors for its freeform maps. Those same shapes and connectors can be used to create maps and diagrams in Excel without BigPicture. So what’s the difference? Here are a few of the key benefits to using BigPicture vs “Excel-alone” for free-form diagramming in Excel.

Adding New Shapes and Connectors

In BigPicture, a new shape and connector can be added to a map simply by dragging the mouse from a connection point and releasing the mouse, or via the Outline Pane where BigPicture will draw the connector and shape for you. In Excel-alone, a multi-step process is required. First, the new shape must be added. Then a connector has to be added and attached manually to the original shape and the new shape.

Labeling Shapes

Both BigPicture and Excel-alone support using cell references to label shapes. Accessing “live” Excel content in a diagram is a major benefit of making a mind map in Excel. The labels of shapes update automatically as the values of cells they reference in Excel change. However, only BigPicture supports using multiple cells to label a single shape. With Excel-alone, you can only reference the contents of a single cell when labeling a shape.
Auto Labeling of Shapes

Shapes can also be automatically labeled by BigPicture when they are added, with “auto-labels” updating as labels are added to shapes. Excel-alone has no facility for auto-labelling shapes.

Labeling Connectors

Connector labels are automatically positioned by BigPicture and adjust properly when shapes and connectors are moved. If a label is placed on a connector when using Excel-alone, Excel does not move or position the label properly when shapes and connectors are moved.
Changing Shape Type

In BigPicture, if the type of a shape is changed (say from a rectangle to a circle), existing connectors stay attached to the new shape type at appropriate connection positions. When using Excel-alone, all connections are lost when the type of a shape is changed. The user must then manually re-attach connectors to the new shape type.

Collapse and Expand

In BigPicture, child shapes may be collapsed and hidden from view when the Collapse shape is clicked at a connection point, and expanded when the Expand shape is clicked. When using Excel-alone, there is no capability for “folding” or collapsing and expanding connections.
Attributes such as Pictures, Markers, Notes and Hyperlinks

In BigPicture, supplementary attribute shapes (such as markers, notes and hyperlinks) can be attached to a shape. These attribute shapes move with the shape as it is repositioned in a map. In addition, the contents of these attributes can be easily edited in BigPicture. If attribute shapes are desired when using Excel-alone, they must be manually grouped with the shape, and ungrouped when they need to be changed or edited.
Navigating Free Form Maps

BigPicture has an Outline Pane (See #1) where all shapes in a map are listed by their label. You can navigate through shapes by clicking on entries in the outline. In addition, you can search and replace label text throughout shapes in open maps. In Excel-alone, a Selection Pane (See #2) can be shown which list shapes by their internal name, such as Rectangle1 or BP_Expand_18_4, (See #3) not their label. No facility is available in Excel to search or replace text in shape labels.
Slide Shows

BigPicture allows you to create slide shows where the map unfolds in any way you like. This is especially useful if you are presenting the map to an audience and you want to explain it in steps. These slide shows can include supporting text and images that are displayed by slide. Excel-alone has no facility for presenting shapes and diagrams step-by-step.
Based on the number mailed and the response rate, the company will observe the number of responses, i.e., the number of customers who purchase something.

Keys:
Blue: given inputs
Red: decisions
Orange: calculated quantities
Purple: bottom line payoff
What platforms are supported?

BigPicture software is compatible with all 32-bit and 64-bit versions of Microsoft Windows XP through Windows 10 and Excel 2007-2016.


BigPicture is currently only available on the Windows platform. It is possible to run BigPicture on a Mac as long as the user has an application (such as BootCamp, VMware, etc.) that “emulates” Windows on it. If you would be interested in pursuing BigPicture on an emulated version of Windows on a Mac, the following information from Palisade’s Knowledge Base may be of interest to you. The following was Excerpted from http://kb.palisade.com/index.php?pg=kb.page&id=1056

Our current Palisade software is supported in these Windows environments hosted on the Mac:
- Windows XP through Windows 10 running using BootCamp.
- Windows XP through Windows 10 emulation using Parallels, VirtualBox, or VMWare. (Parallels users, launch Microsoft Excel for Windows in Parallels before launching BigPicture. To avoid the need to launch Excel first, use the Registry editing technique described in Which Version of Excel Is Opened by Palisade Software?)

If you have a Mac, you might like to review the Apple Store’s article Mac Basics Windows on a Mac (accessed 2014-06-13).
BigPicture Documentation

BigPicture provides a link to the most recent Help files available for BigPicture and also installs a PDF file that is compiled at the time of the most recent release.

On-Line Help Files

You can access the latest and greatest Help documentation by clicking on the Help icon in the BigPicture Ribbon, then Documentation>Help. This will take you to our on-line Help that is updated on a continuous basis.

PDF Help File

Alternatively, if you click on the Help icon in the ribbon and then select Documentation>Manual, it will open the PDF version of the BigPicture Manual that was last updated upon release of the version of BigPicture that you are currently running.
What's New in BigPicture?

February 2016 Release

In February 2016 Palisade officially released BigPicture 2016 v.1.

Data Cleaning for Data Maps, Linked Maps and Organizational Charts

BigPicture can now check your data sets to find and correct inadvertent misspellings, capitalization differences, spacing issues etc. that would keep your Data Maps, Linked Maps and Organizational Charts from being generated properly.
New Data Map Calculation Options

BigPicture can now calculate a variety of additional statistics on your data, show those statistics in End Tables and display them as rollup calculations in your Data Maps. *(See #1)*

You can also calculate multiple statistics on the same column in your data set. These statistics can be shown in End Tables and displayed as rollup calculations in your Data Maps. *(See #2)*
Improved Data Map End Tables

Data Map End Tables are not displayed in floating windows as in previous versions of BigPicture, but are in a single task pane to the right. You can stack and sort multiple tables by selecting the "Display Multiple Tables" option.
Improved Conditional Formatting

BigPicture has improved support for coloring topics with conditional formatting from linked cells. Map topics pick up both conditional format cell colors and conditional formatting icons from linked cells. Data Maps and Organizational Charts can also link to conditional formatting in data. In true BigPicture style, topic color and icons change when the format of linked cells change.
Tags
Tags or text markers can be attached to map topics to describe and group topics. Tags can have Excel formatting attached to them so topics and connectors that have common tags will be formatted the same.
Improved Marker and Tag Entry

A single dialog now allows you to assign any number of markers to one or more topics at the same time. Similarly, the Tags dialog behaves the same way - providing an easier way to add tags to multiple topics at once.

Enhanced Outline Pane

The Outline Pane has been updated to allow you to add topics, delete topics, rearrange topics via drag-drop, and copy/paste topics. Topics may be grouped by markers or tags in the outline view and markers and tags can be added or removed via the new Outline Pane.
Import from Text Outline to Map

BigPicture can now import a text outline and create a map from it, or export a map to an outline where it can be edited and re-imported.
New Example Files

To help demonstrate some of BigPicture's new features the following Example Spreadsheets have been added to BigPicture. Example Spreadsheets can be accessed via the Help dropdown menu. *(See #1)*

- Conditional Topic Color with Icons.xlsx
- Outline to Map.xlsx
- Simple Org Chart with Conditional Formatting.xlsx
- Tags and Markers.xlsx

A Selection of Significant Fixes

- Improved the auto-sizing of topics in Data Maps
- Improved right-click options for Connectors
- Topic Pane's Picture: Keep Size and Position now saves changes to picture rotation
- Improved the presentation of text in some non-English dialogs
Example Spreadsheets and Videos

Are example maps available?

Yes, BigPicture comes with a number of example maps that illustrate the various uses of the software. Example maps can be found via the Example Spreadsheets option of the Help menu.

Select Example Spreadsheets under Help

This opens the file BigPicture Example File List.xlsx, where you can select a category and then an example from that category.
### BigPicture Examples

<table>
<thead>
<tr>
<th>Examples in Specific Business Areas</th>
<th>Examples Highlighting Product Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Concepts</td>
<td>Basic Maps</td>
</tr>
<tr>
<td>Business Planning</td>
<td>Markers and Tags</td>
</tr>
<tr>
<td>Human Resources</td>
<td>Data Maps</td>
</tr>
<tr>
<td>Data Analysis</td>
<td>Linked Maps</td>
</tr>
<tr>
<td>Decision Analysis</td>
<td>Organization Charts</td>
</tr>
<tr>
<td></td>
<td>Slide Shows</td>
</tr>
<tr>
<td></td>
<td>Free Form Maps</td>
</tr>
</tbody>
</table>

**Introduction**

Click here for an introductory video of BigPicture.

**More on the Web**

Click here to find more videos on the Palisade website.

![Video Icon](image)

This icon indicates that an online video exists to illustrate this example. Click the icon to watch the video.

![Sequence Icon](image)

This icon indicates that this example is part of a larger sequence of examples. Click the icon to see the full sequence.

**Note:** Some examples appear multiple times in this list because they apply to more than one category.

### Basic Maps

**Simple maps that illustrate some of BigPicture's features**

- **Topics Show Excel Calculations.xlsx**
  - A map that takes topic labels from Excel cells

- **Sales with Possible Competitor Entry.xlsx**
  - A more complex map that labels topics from Excel cells
Are videos available?

Yes, several videos have been created to explain various features of BigPicture maps. You can view them here or find a list of them on the Palisade website at http://www.palisade.com/BigPicture/Intro/EN/. You are also encouraged to visit our BigPicture Playlist on our Palisade YouTube page, where you will find recordings of previous webinars that may be of interest to you.

Video: Basic Introduction to BigPicture

Video: Demo of BigPicture

Gain insight on how BigPicture can help you.
Map Basics

How do I start a new map?

There are two ways to start a new map.

Method 1: Click the New Topic button on the BigPicture ribbon

Click the New Topic button on the BigPicture ribbon. The new topic is placed at the location of the active cell.
Method 2: Right-click a cell and select New Topic

Select a cell where you want the new topic to be placed and right-click. To the right of Excel's shortcut menus, you will see a BigPicture shortcut menu, and you can select **New Topic** from it.

![Right-click menu](image)

Method 3: Creating a New Map from an Outline

You can use the Outline Pane as an easy way to create a new map by quickly adding individual topics or by importing an outline from a text editor like Microsoft Word.

**Via Manual Entry**

Click the Outline View, and then start typing in the <New Topic> box. Each time you hit <Return> a new topic will be added to the map. This allows you the freedom of being able to brainstorm without having to worry about what order your topics are in. You can click and drag the topics in the outline to move them to appropriate locations.

**Via Import of Outline**

Copy the outline form your text editor. Note that the outline is a simple outline with a tab indentation to denote new levels. You can also copy your outline from an Excel worksheet where a new column represents a new level. BigPicture has included an example file `Outline to Map.xlsx` file that you can practice with. Here are the steps.

- Open a blank workbook
- Click on the Outline icon in the View section of the BigPicture Ribbon *(See #1)*
- Click OK when asked if you would like to use the Outline to create a new map.
- Copy the Outline from either Word, Excel or other program *(See #2)*
- Click on the top entry in the Outline Pane (Map - Sheet1)
- Click the import button
- Click OK

BigPicture builds the map for you. *(See #3)*
Can I create several topics all at once?

Yes, this is possible from the New Topics From Cells command described below, as well as via the Add Children command or via the Outline Pane.

Add Topic via the New Topics From Cells Command

Begin by adding topic labels to a range of cells. This is often a good idea in any case, because it helps you to think about the topics you want in the map. Alternatively, if there are already cells with text and numbers, you can use them to label your topics.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Number mailed</td>
</tr>
<tr>
<td>2</td>
<td>Response rate</td>
</tr>
<tr>
<td>3</td>
<td>Number of responses</td>
</tr>
<tr>
<td>4</td>
<td>Average order size ($)</td>
</tr>
<tr>
<td>5</td>
<td>Total revenue</td>
</tr>
<tr>
<td>6</td>
<td>Variable cost per order</td>
</tr>
<tr>
<td>7</td>
<td>Total variable cost of order</td>
</tr>
<tr>
<td>8</td>
<td>Variable cost of printing and mailing</td>
</tr>
<tr>
<td>9</td>
<td>Total variable cost of printing and mailing</td>
</tr>
<tr>
<td>10</td>
<td>Fixed cost of printing</td>
</tr>
<tr>
<td>11</td>
<td>Total cost</td>
</tr>
<tr>
<td>12</td>
<td>Profit</td>
</tr>
</tbody>
</table>

Select New Topics From Cells

Click the New Topics dropdown arrow. Select New Topics From Cells. NOTE: You can also select this command by right-clicking a cell and selecting New Topics From Cells from the BigPicture pop-up menu.
Select Parent Topic

If you want the new topics to be connected to an existing topic, select the Parent Topic here. Simply click the topic shape in the map. If you accept the <no parent topic> default, as is done in this example, the new topics will be unconnected.

Select label range

Select the range that contains the topic labels. NOTE: You can also CTRL+Click to select columns of data that are not located next to one another.
View the topics

A separate topic is added automatically for each label cell. You can then move them around and connect them as you like. This is especially helpful when you are creating a free form map.

(Optional) Change labels

The topic labels are linked to the cell labels. In this example, the first cell label was changed from "Number mailed" to "# mailed", and the topic label changed automatically.
Number of topics created

The number of new topics BigPicture creates depends on the type of range you select and the data in the range. BigPicture tries to determine what topics you want from your range and create them automatically. Below are some typical examples. NOTE: You can also specify the # of cell per topic label by <Shift> clicking on OK.

Label with number next to it

If you select these two cells, BigPicture will create a single topic with both cells as labels.

Label with number below it

This will also result in a single topic with both cells as labels.
Multiple labels and numbers

If you select this range, BigPicture will create three topics, one for revenue, one for cost, and one for profit. Each will show the text and the associated dollar value.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td>$150</td>
<td></td>
</tr>
<tr>
<td>Cost</td>
<td>$100</td>
<td></td>
</tr>
<tr>
<td>Profit</td>
<td>$50</td>
<td></td>
</tr>
</tbody>
</table>

Stacked multiple labels and numbers

This range will also lead to three topics, the same as in the previous example.
Create topics from a non-consecutive range

For this example we only want BigPicture to display the information in Columns A, B, C, F and G. In other words, we would like to have each topic display the player’s number, name, total points, # of rebounds and # of steals.

Add Topics via Add Children Command

- Click on the topic that you would like to be the Parent Topic. (See #1 - For this example we have converted a picture into a BigPicture Topic)

- Right-click and select Add Children from the BigPicture pop-up menu. (See #2)
- Select the cells that contain the label that you want as Children Topics *(See #3)*

- Click OK *(See #4)*

- BigPicture will automatically draw out the map with the Children Topics connected to the chosen Parent Topic. *(See #5)*
How do I create connections between topics?

Method 1: Drag from a red square

If you want to create a connection to a new topic from an existing topic, hover the mouse over the existing topic until you see a red square on the top, bottom, or sides. Then drag from this red square in any direction. When you let go of the mouse, a new topic will be created, connected to the existing topic. Its placement depends on whether Auto Arrange (on the BigPicture ribbon) is on or not. If Auto Arrange is off, the new topic will be placed where you let go of the mouse. If Auto Arrange is on, its placement will be automatic.

Method 2: Drag from a red square to a red circle

Assuming the two topics already exist, hover the mouse over the origin topic until you see a red square on the top, bottom, or sides. Then drag from this red square toward the destination topic until you see a red circle on the top, bottom, or sides, and make sure the connector ends at one of these red circles. (The other circle in the graphic below illustrates one of the other possible connection points.)
Method 3: Right-click a cell and select New Connected Topic

Assuming one or more topics already exist, you can right-click a cell and select New Connected Topic from the BigPicture shortcut menu. This creates a new topic, placed at that cell, which is connected to the closest existing topic based on the direction of the map.
What are the red squares and circles on topics?

The red squares and circles that appear when you hover over a topic represent where connectors can be attached to those particular topics.

Red squares

When you hover the mouse over a topic, you see red squares on the top, bottom, and sides. These indicate the possible positions for the origin of a connector.

Red circles

When you drag a connector from a red square origin of one topic toward another topic, you see red circles on the top, bottom, and sides of the destination topic. The red circles indicate where the connector can be attached to the other topic.
How do I enter or modify a topic label?

There are a variety of ways to modify a topic label.

Method 1: Select a topic and start typing

If the topic is blank, select the topic and type the label you want. If the topic already has a label, you can select the part you want to change and type over it.

Method 2: Enter (or modify) the label in the Outline pane

- Click the **Outline** icon on the BigPicture ribbon (See #1) to show the Outline pane on the left.

- Select a topic in this pane and type (or modify) its label. *(See #2)*

- When you press the Enter key, BigPicture will automatically go to the next Topic in the list where you can edit that label as well.

If you would like to add a New Topic rather than updating one that has been drawn out already:

- Click on the Topic that you would like to be the Parent of the New Topic

- Then enter the name in the `<New Topic>` field. *(See #3)*

- BigPicture will automatically add the New Topic extending out from the initial Parent Topic that you chose.
Method 3: Enter (or modify) the label in the Topic pane

- Click the Topic button on the BigPicture ribbon to show the Topic pane on the right.
- Select a topic in the map.
- Type (or modify) its label in the Label section of the Topic pane.
How do I link a topic label to a range?

You can make a topic label dynamic by linking it to a single-cell or even a multiple-cell range. Then if those cell contents change, the topic label will update automatically. This is especially useful if the range contains formulas that change when input data change.

Enter values and/or formulas in a range

Here is an example where the revenue from a sale is based on the four inputs above it.

Method 1: Select the range via the Label option

Right-click the topic to bring up the shortcut menu and choose Label.
Click and drag to select the range for the label

In this case, the revenue and the label to its left have been selected.

<table>
<thead>
<tr>
<th>Number sold</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit price</td>
<td>$49.99</td>
</tr>
<tr>
<td>Discount</td>
<td>5%</td>
</tr>
<tr>
<td>Tax rate</td>
<td>6.50%</td>
</tr>
<tr>
<td>Revenue from sale</td>
<td>$151.73</td>
</tr>
</tbody>
</table>

Method 2: Specify the range via the Topic Pane

Click the Topic button on the BigPicture ribbon

Click the **Topic** button in the **View** section of the BigPicture Ribbon. This opens the Topic Pane on the right, where you can make many types of changes to any of the topics.

Select the **Label From Excel Range** and click and drag to select the range for the label

Select the **Label From Excel Range** option, click the button to its right, and click and drag to select the range.
View the result

The label appears, aligned nicely, although you might need to resize the topic.

Change data in the linked range

It's dynamic! Any changes you make that change the linked range are reflected automatically in the topic label. Here the number of units sold has been changed from 3 to 5.
Try using a larger linked range

Substitute the smaller selection above with a bigger one in either of the methods described.

Select several labels and the corresponding numbers

View the result

Again, the contents of the topic label are aligned nicely, although you might need to re-size the topic.
Select non-contiguous columns of data to create/label multiple topics at once

After selecting your range of data when creating new topics from cells (See #1), or when labeling a topic from cells, you can <Shift> click OK (#2) to specify the # of cells per topic label (#3).

In the following example we selected non-contiguous columns of data and asked BigPicture to use all 21 cells to label 1 topic. The resulting topic puts the 3 columns that were selected into one topic. (#4)

(Optional) Change to a static label

If for any reason you want to change from a dynamic (linked) label to a static (unlinked) label, it is easy to do so.
Open the Topic Pane and select the Simple Label option

Click OK to confirm this action

View the label and change it if necessary

The contents of the linked cells are automatically used for the simple label. No typing is necessary unless you want to modify the label in some way.
<table>
<thead>
<tr>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Number sold</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Unit price</td>
<td>$49.99</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Discount</td>
<td>5%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Tax rate</td>
<td>6.50%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Revenue from sale</td>
<td>$252.89</td>
</tr>
</tbody>
</table>

Revenue from sale $252.89
How do I add pictures to topics?

You can add pictures to topics in a variety of ways. You can add a picture inside a topic, as a marker on the outside of a topic, or as the topic itself. Below are three ways to add pictures in BigPicture.

Method 1: Add a Picture Inside a Topic

You can add a picture inside a topic via the Topic Pane or via the BigPicture pop-up menu.

Add a Picture Inside a Topic via the Topic Pane

1) Click the Topic button in the View section of the BigPicture ribbon to display the Topic pane to the right.

2) Click the desired topic in the map to select it.

3) Click the Picture option in the Topic pane and click in the Include Picture box.

4) After the default BigPicture image has appeared in the topic, right-click the image and choose Change Picture.

Note: After a picture has been added to a topic you can change its properties via the Topic Pane.
Add a Picture Inside a Topic via the BigPicture pop-up menu (Alternate Option)

1) Right-click on the Topic and choose **Add Picture** from the BigPicture pop-up menu

2) A default BigPicture image will be placed in the Topic

3) Right-click on the default BigPicture image inside the Topic and select **Change Picture** and browse for the image you would like to use.
Note: You can adjust the position and size of the picture using the options listed in the Picture section of the Topic Pane.

Method 2: Adding a Picture as a Marker on the Outside of a Topic

Add a Picture as a Marker via the Topic Pane

1) Click the **Topic** button in the View section of the BigPicture ribbon to display the Topic pane to the right of your workbook.
2) Click the desired topic in the map to select it.

3) Click the Markers option in the Topic Pane

4) Next to the desired marker list, click in the Marker column and use the drop-down list to select a marker.

5) Your selected marker will appear to the lower-right side of your Topic

*Note: If you would like to use one of the markers as a picture inside the topic (as described in Method 1: Add a Picture Inside a Topic) you can click on the Change Marker to Picture button. (See #4 below.*)
Add a Picture as a Marker via BigPicture pop-up menu (Alternate Option)

1) Right click the Topic

2) Select **Markers** from the BigPicture pop-up menu

3) Select a List and a Marker from the corresponding pop-up menus.
Method 3: Add a Picture to Represent a Topic

You can also make the Topic itself appear as an image.

Add a Picture to Represent a Topic in Excel 2013

1) Right-click the topic

2) Click Fill in the Excel pop-up menu
3) Select **Picture**… and browse for your desired image

**Add a Picture to Represent a Topic in Excel 2010**

1) Right-click the topic.

2) Select **Format Shape**…

3) Select **Picture or Texture Fill** from the Fill Menu

4) Choose to include an image from either a file, from the Clipboard, or from a Clip Art library
How do I use Undo?

The important aspect to understand when dealing with "undos" is that some manipulations that you will do to your map will be part of Excel's capabilities, while other manipulations are part of BigPicture's capabilities.

If you have made changes to the formatting of a shape, font, image, etc. you will be able to utilize Excel's standard Undo/Redo commands located in the top left corner of Excel.

If you have added/removed/moved topics, connectors, boundaries, custom shapes, etc. you will utilize the Undo/Redo options in the Undo drop down menu located in the BigPicture ribbon.

This capability also allows you to Undo an Auto Arranged map if you decide that you don't like the default way BigPicture arranges your preexisting map when you select Auto Arrange from the BigPicture ribbon.

NOTE: The collapsing/expanding functionality of BigPicture is not included in the list of operations that are able to be undone.

Undo for Excel Commands

Click on the Excel Undo icon after you have executed a standard Excel command, such as changing the color or format of a topic.

Note: You can also use the shortcut Ctrl+Z to undo an Excel command.

Undo for BigPicture
Click on the **BigPicture Undo** button in the BigPicture ribbon to undo a BigPicture action. The **Undo** button on the BigPicture ribbon will be enabled when BigPicture Undo is available.

*Note: BigPicture Undo is only available for "free-form" maps. Auto-generated maps, such as Data Maps and Org Charts, do not have BigPicture Undo. The structure and content of these maps is controlled by BigPicture. If you want to change the structure or content of these maps, you should change the original data set or dialog settings and regenerate the map. Auto-generated maps, however, can use Excel's Undo whenever it is applicable.*
How do I Convert Excel Shapes to BigPicture Topics

Excel shapes and imported images can be converted into BigPicture Topics. This is especially useful if you have already created some type of map using Excel’s native shapes and drawing tools. Once converted, these shapes can then be linked, collapsed, expanded and annotated as any other topic.

How do I Convert an Excel Shapes and Pictures to a BigPicture Topic?

You can convert an Excel shape or an inserted image into a BigPicture Topic by selecting the shape and choosing Utilities>Convert Existing Excel Shapes to Topics…

Example

- Insert an image(s) via Excel's Insert tab (See #1)
- Click on the image(s)
- Click on the Utilities drop down menu in the BigPicture ribbon and select Convert Existing Excel Shapes to Topics… (See #2)
- Click Yes when asked if you would like to convert the shapes (See #3)
BigPicture will now provide connection points on the converted images, allowing you to "draw" out new topics. (See #4)

Excel Shapes that are able to be Converted to BigPicture Topics

Here is a diagram of all of the Excel shapes that can be converted into BigPicture Topics. Any shape highlighted in green is able to be converted.
Topic Pane and Outline Pane

What is the Topic pane, and why would I use it?

The Topic pane is an alternative to the BigPicture shortcut menu you get when you right-click a topic. It is a handy place to change properties of any of the topics.
Topic Pane Items

The Topic pane has a variety of subsections to make it easier for you to edit topics. Click on any Topic in your map and then add/alter any of the following attributes of that topic:

- Label
- Note
- Pictures
- Markers
- Hyperlinks
- Format
- Tags
Label
The label section allows you to enter a simple label in the Simple Label field or you can choose to link to a cell(s) in your workbook. If you choose to label using an Excel Range, you will be able to add more information to your individual topics.
Note

A note is represented with a small icon in the lower right of your topic. You can enter the note contents via the Topic Pan and choose whether or not to leave the note open or not.
Picture

You can use the Topic Pane to add a picture to your topic. When you first click in the Include Picture box it will put a placeholder image in your topic. Right click on that image to add your own image.
Markers

Markers are small icons that can help tell a story about your topic at a quick glance. You can choose which marker you would like to use by clicking in the cell to the right of the list name in the Markers section of the Topic Pane and select the marker from the drop down menu.
Hyperlinks

You can easily link to other documents, spreadsheet, pdf files, websites, etc. by adding a hyperlink to your topic. To do so, click on the green Add icon (See #1) and search for your file or enter a web address in the Address field. (See #2)
Format

You can choose to show topics as labels only or you can choose to link to a cell format. If you choose to link to a cell format, click on the excel range icon and choose the cell that contains the formatting that you would like to use.
Tags

Similarly to Markers, you can choose to add Tags via the topic pane by selecting them from the drop down menus that appear when you click in the box to the right of the Group name.
What is the Outline Pane, and how do I use it?

Once you have created a map, the Outline Pane provides a variety of ways that you can easily create/edit entire maps, add Topics, delete Topics, rearrange Topics via drag-drop methods, duplicate topics, add Tags, add Markers, import/export Outlines and have access to various summary views. The versatility of the Outline view makes BigPicture incredibly user friendly.

Outline Pane Overview

To access the Outline Pane click on the Outline icon in the BigPicture Ribbon.

Basic Outline View

To access the Basic Outline View click on the Outline icon in the upper left corner of the Outline Pane. This view allows you to see your entire map as an outline. It also gives you the opportunity to add, remove, edit and of your Topics and Connectors. When in Basic Outline View the Import (See #2) and Export (See #3) icons are available. These features are covered below.
Tags Outline View

To access the Tags Outline View click on the Tag icon (See #1) located to the right of the Basic Outline icon. This view allows you to see your Topics and Connectors and how they are tagged throughout your map. It also gives you the flexibility to add new tags, reassign tags and remove tags at the same time that it automatically updates the map. When viewing the Tags Outline, the Tags Option icon (See #2) is made available. These options allow you to view and filter different combinations of Tags in conjunction with specified Markers that are assigned to your map.
Markers Outline View

To access the Markers Outline View click on the Marker icon (See #1) to the right of the Tags icon in the Outline Pane. When viewing the Markers Outline, the Markers Option icon (See #2) is made available. These options allow you to view and filter different combinations of Markers in conjunction with specified Tags that are assigned to your map.
Show Connections Option

Click on the **Show Connections** button at the bottom of the Outline Pane *(See #1)* to view all of the connections in the outline. When the Show Connections option is activated, the color of the button will change colors - as shown below. A small gray arrow will appear *(See #2)* on the side of any connectors in the Outline. The default name given to connectors is based on the two topics that are attached to that connector. You can add labels to the connectors by clicking on them in the outline and typing the label name.

**NOTE:** When **Show Connections** is NOT activated, you can click on the connector(s) in the map and they will appear in the Outline. This comes in handy when you only want to see some of the connectors instead of all of them. If you would like to clear the connection
that appear in the outline view after clicking on individual connections. Click on the Show Connections button twice.

Find and Replace Option

Click the **Find and Replace** button at the bottom of the Outline Pane to see the usual find and replace options. Click on the Options button to access the Whole Word and Match Case options.
Basic Outline View Features

Adding Topics

To Add Topics via the Outline,

- Click on the topic name that you would like to have as the parent topic
- Type the name of the Topic that you would like in the <New Topic> area
- Click Enter or Tab
You can continue to add topics to that selected parent by continuing to enter names and clicking <Enter>. The New Topics will be added as children topics to the selected topic in the outline.

Creating a New Map from an Outline

You can use the Outline Pane as an easy way to create a new map by quickly adding individual topics or by importing an outline from a text editor like Microsoft Word.

Via Manual Entry

Click the Outline View, and then start typing in the <New Topic> box. Each time you hit <Return> a new topic will be added to the map. This allows you the freedom of being able to brainstorm without having to worry about what order your topics are in. You can click and drag the topics in the outline to move them to appropriate locations.
**Via Import of Outline**

Copy the outline form your text editor. Note that the outline is a simple outline with a tab indentation to denote new levels. You can also copy your outline from an Excel worksheet where a new column represents a new level. BigPicture has included an example file **Outline to Map.xlsx** file that you can practice with. Here are the steps.

- Open a blank workbook
- Click on the Outline icon in the View section of the BigPicture Ribbon *(See #1)*
- Click OK when asked if you would like to use the Outline to create a new map.
- Copy the Outline from either Word, Excel or other program *(See#2)*
- Click on the top entry in the Outline Pane (Map - Sheet1)
- Click the import button
- Click OK

BigPicture builds the map for you. *(See #3)*
Moving Topics via Drag and Drop

- Click and drag the topic(s) that you would like to move (See #1) while dragging, a blue triangle will appear.

- Drag the blue triangle over the topic that you would like to have as the Parent topic. (See #2)

- Release the mouse - BigPicture will automatically move the topic(s) in the outline and in the map. (See #3)

If you click and hold on a topic that has Children topics, they will also be selected and able to be moved to another location. When you move a topic to another location, BigPicture will make the proper adjustments to the connections.
You can use the <Ctrl> or <Shift> to select multiple topics. Continue holding the <Ctrl> or <Shift> key down while dragging the selected topics to a different position in the outline and the map will update accordingly. (*This example is shown in the image below.*)

If you select a connector in the map, its entry will appear in the outline. You can then drag topic(s) onto the connector and they will be inserted between the topics linked by that connector.
Copy/Paste Topics

If you would like to duplicate a topic(s) to another section on your map, you can utilize the standard Copy/Paste functionality within the Outline Pane and your map will update automatically.

- Select the topic names in the Outline Pane that you would like to duplicate.
- Right click and choose Copy OR <Ctrl-C> to copy them.
- Click on the Topic(s) that you would like to add to.
- Right click and choose Paste OR <Ctrl-V>, which in turn will automatically update your map.

Deleting a Topics

If you would like to delete a topic, you can do so by clicking on the topic itself in the map, or by clicking on the topic name in the Outline, then pressing the <Del> key. After deletion, reconnection is more intelligent than just deleting the topics in the map. BigPicture will then connect the neighboring topics.

Right-click a topic

You can right-click a topic(s) to bring up the usual BigPicture shortcut menu, where you can modify the topic in many ways including adding boundary shapes, markers, notes, tags, etc.
Import Function

The Import Function allows you to copy an outline, or portion of an outline, from a text editing program such as Microsoft Word, or from another Excel Worksheet and import it into the outline that will automatically update the corresponding map. Outlines are simple indented lists that provide topic names and hierarchies for a map.

To Import a section into the outline:
- Copy the text that you would like to import (See #1)
- Select the name of the Topic that you would like to add the new Topics to (See #2)
- Click on the Import icon in the Outline Pane (See #3)
- A message will appear asking you if you would like to add the new Topics to the selected Topic location (See #4)
- Click OK

BigPicture will add the copied text into the Outline and will created the appropriate Topics (See #5)

NOTE: You can import entire outlines or small portions - like show here. To Import an Entire Map, simply copy the outline to the clipboard in Word, click on the top Map Entry in the Outline Pane and click on the import icon.
Tags Outline View Features

You can utilize the Outline Pane to view, add, remove and edit tags that are assigned to your topics. You can also use the Options feature within the Tags Outline View (See #1) to group your topics based on their Tags.

- Open the Outline Pane via the Outline icon in the View section of the BigPicture Ribbon (See #2)

- Click on the Tags icon to open the Tags View of the Outline Pane (See #3)

NOTE: Any topics that are not yet tagged will appear in the Not Tagged section of the outline. (See #4)
Adding, Removing, Editing Tags via Outline

You can add Tags directly from the outline in the Tags View. Note that if you have tags already assigned to some topics, those Tags will be listed and the Topics that are assigned to that particular Tag will be listed below it. Topics that do not have a Tag assigned to them yet, will appear in the Not Tagged section of the outline. (See #1)

Add a Tag via Right Click

- Right click on the topic name in the outline that you would like to tag
- Select Tags in the pop up menu
Choose the tag option that you would like in the Tags Dialog window.

**Add a Tag via Drag and Drop**

Any topics that are not yet tagged will appear in the Not Tagged section of the outline.

- Click on the Topic(s) that you would like to Tag. When you click and begin to drag, a blue triangle will appear. *(See #2)*

- Drag and drop it onto the Tag that you would like to assign to it. *(See #3)*

- BigPicture will automatically assign the Tag attributes to that Topic in the map. *(See #4)*

**NOTE:** If the tag you are looking for does not exist in the outline because it has yet to be assigned to a topic, you can add a placeholder (blank) tag to your outline by clicking on the Gear icon *(See #5)* and selecting the Tag(s) that you would like to add. As soon as you click on the Tag name in the dialog, it will automatically be added to the outline so that you can drag and drop the topics onto the tag names.

---

**Tag Options for Outline**

In addition to viewing your Topics grouped by their Tag type as shown above, you can utilize the Options dialog to create Summary views, add Tags to the Outline, and display a specified Marker in the outline itself.

**Summary Views (See #1)**

For example you could view which topics have High Importance and are only at 50%.

- Click on the Gear icon in the Tags View Outline

- Select the Summary By Group option
Select Importance from the Group #1 drop down menu

Select Progress from the Group #2 drop down menu

BigPicture will rearrange the outline view to show all of the combinations of Importance and Progress.

Adding Tags to Outline List (See #2)

If the tag name that you are looking for does not exist, simply select it from the Tag drop down menu to the right of the Group. As soon as you select it, it will be added to the outline.

Show Markers (See #3)

Select the marker of your choice to have it display in the Tags outline by choosing it from the drop down menu.
Markers Outline View Features

You can utilize the Outline Pane to view, add, remove and edit Markers that are assigned to your topics. You can also use the Options feature within the Markers Outline View to group your topics based on their Markers.

- Open the Outline Pane via the Outline icon in the View section of the BigPicture Ribbon (See #1)

- Click on the Markers icon to open the Markers View of the Outline Pane (See #2)

*NOTE: Any topics that do not have markers will appear in the No Markers section of the outline. (See #3)*
Adding, Removing, Editing Markers via Outline

You can add Markers directly from the outline in the Markers View. Note that if you have Markers already assigned to some topics, those Markers will be listed and the Topics that are assigned to that particular Marker will be listed below it. Topics that do not have a Marker assigned to them yet, will appear in the No Markers section of the outline. (See #1)

Add a Marker via Right Click

- Right click on the topic name in the outline that you would like to add a Marker to
- Select Markers in the pop up menu
Choose the Marker option that you would like in the Markers Dialog window.

**Add a Marker via Drag and Drop**

Any topics that do not have a Marker will appear in the No Markers section of the outline.

- Click on the Topic(s) that you would like to add a Marker to. When you click and begin to drag, a blue triangle will appear. *(See #2)*

- Drag and drop it onto the Marker that you would like to assign to it. *(See #3)*

- BigPicture will automatically assign the Marker the Topic(s) in the map. *(See #4)*

**NOTE:** If the Marker you are looking for does not exist in the outline because it has yet to be assigned to a topic, you can add a placeholder (blank) Marker to your outline by clicking on the Gear icon *(See #5)* and selecting the Marker(s) that you would like to add. As soon as you click on the Marker name in the dialog, it will automatically be added to the outline so that you can drag and drop the topics onto the Marker names.

**Marker Options for Outline**

In addition to viewing your Topics grouped by their Marker type as shown above, you can utilize the Options dialog to create Summary views, add Markers to the Outline, and display a specified Tag in the outline itself.

**Summary Views (See #1)**
For example you could view which topics have High Importance and are only at 50%.

- Click on the Gear icon in the Markers View Outline
- Select the Summary By Group option
- Select Importance from the Group #1 drop down menu
- Select Progress from the Group#2 drop down menu
- BigPicture will rearrange the outline view to show all of the combinations of Importance and Progress.

Adding Markers to Outline List (See #2)

If the Marker name that you are looking for does not exist, simply select it from the Marker drop down menu to the right of the Group. As soon as you select it, it will be added to the outline.

Show Tags (See #3)

Select the Tag of your choice to have it display in the Markers outline by choosing it from the drop down menu.
**Tools for Modifying Maps**

What is Auto Arrange, and when should I use it?

*Auto Arrange helps to maintain symmetry in your map.*
Auto Arrange for a symmetric map

If you want topics to be arranged symmetrically, Auto Arrange is a big help. Instead of having to position topics manually, you can let BigPicture do it for you.

Draw map with Auto Arrange off

Here is the start of a map with Auto Arrange turned off. The placement of topics isn't bad, but it isn't perfect.

Turn Auto Arrange on

Here is the result when Auto Arrange is turned on. Actually, you can turn it on before creating the map or after. Each has the same effect. Then when you add new topics, the
current topics will rearrange automatically to retain the symmetric appearance. However, don't be surprised if the entire map moves to a slightly different location on the worksheet when you add topics. This occurs when the map requires more space for its new topics.

If you create the map in the previous step (with Auto Arrange off), then turn Auto Arrange on, and then turn it off again, the map will *not* revert to its previous non-symmetric layout; it will remain symmetric. However, you will then be able to position *new* topics as you like.

**Auto Arrange for free-form maps**

This is *not* the option you want if you want to decide on the placement of topics. This will enable you to build a symmetrically-organized free-form map. However, it will not allow you to *choose* where you would like to place your topics. Below is an example of what will happen when a free-form map is created with the Auto Arrange option turned off and then when it is turned on.

**Create a free-form map with Auto Arrange off**

Here is a typical free-form map for investment decisions. The topics have been positioned to tell the story best (and to avoid a lot of overlapping connectors).
Save a version of your map prior to turning on Auto Arrange

We recommend saving a copy of your free-form map prior to choosing **Auto Arrange**. Turning Auto Arrange on may move your topics and connectors to positions that don't represent what you would like to see. You will typically want to avoid using this command on free-form maps. If you try to Auto Arrange your map and you don't like the layout, click **Undo** to get to your previous layout.
What is the Single Expand option, and when should I use it?

The Single Expand option reduces clutter and lets you focus on a particular section of the map. When it is turned on and you expand from a topic at a given level of the map, the branches shown from other topics at that level collapse.

Turn Single Expand on (or off)

This option is a toggle. There are three ways to turn it on (or off).

Method 1: Click the Single Expand button

You can click the Single Expand button on the BigPicture ribbon. The option is on when the button is highlighted; it is off when the button is white (as shown here).

Method 2: Select from the Map Settings dropdown list

You can choose the Single Expand Collapses Open Branches item from the Map Settings dropdown list. The option is on when there is a check mark next to this item; it is off when there is no check mark (as shown here).
Method 3: Change an Application Setting

You can change the default behavior in Application Settings (from the Utilities dropdown list on the BigPicture ribbon). This affects the current map and future maps.
Watch the effect
The following steps illustrate the effect of Single Expand being on.

Draw a map
At the outset, as you are drawing a map, all topics remain visible, regardless of the Single Expand state. It is later, when you have opted to collapse topics, that the Single Expand state becomes relevant.
Collapse all topics at some level
Expand one of the topics

Expand another topic at the same level
Here you see the effect. The topics emanating from the upper topic automatically collapse when the bottom topic is expanded. If you then expand the top topic, the bottom topic collapses, and you are back to the map in the previous step.
How do I format several topics the same way?

You can use Excel's tools to format topics in many ways, such as changing the shape, the background color, the font size of the label, the label placement within the topic, and others. The methods discussed here speed up the process of formatting multiple topics at one time. For either of the methods described below, you can also select multiple topics by using the Outline Pane and by using BigPicture's Select Options.

Method 1: Select multiple topics and then format

Starting from a default format, you can select multiple topics, such as all children at a certain level, and then use Excel's tools to format them as you like. We recommend selecting one object and then using SHIFT+click to select the others. CTRL+click to select the others also works but can result in copies of the objects being made if the mouse is moved during the click action.
Method 2: Copy and then apply a copied format

Format a topic
Start by using Excel's tools to format a topic in some way.

Right-click and select Copy Format
Right-click the formatted topic and select **Copy Format** from the BigPicture shortcut menu.
Right-click and select Apply Copied Format

Select all of the other topics you want to format, right-click, and select **Apply Copied Format** from the BigPicture shortcut menu. This formats all of them at once.
BigPicture 2016 Manual
Why would I use connector labels, and how do I create them?

Labels on connectors are optional, but you might want to use them to denote relationships in some way. BigPicture has many prebuilt labels, like "+", "-", "Yes", and "No", that you can use, or you can enter any label of your choice. You can add label to connectors via the Ribbon, Shortcut Menus, and the Outline Pane of BigPicture.

Method 1: From the Connectors drop-down list

Select one or more connectors. Then, click on the Connectors drop-down menu on the BigPicture ribbon and select the Add Label option.

Method 2: By right-clicking

Select one or more connectors and then right-click. This opens the BigPicture shortcut menu. Select the Connector Label option.
Label Connectors from Cells

Similar to the way Topics can be labeled with a cell reference, connectors also have that capability, as well.

- Right-click on the connector that you would like to label.
- Choose Connector Label > Label from the BigPicture pop-up menu.
- Select the cell that you would like to reference.
- Click OK.

NOTE: If you would like to label more than one connector with the same cell reference. Simply select the connectors that you would like to label and then right-click on one of them to access the Connector Label > Label option.
Method 3: Via the Outline Pane

You can label connectors in two ways via the outline pane. You can either type the label you want directly in the Outline, or right-click a connector in the outline to open the BigPicture shortcut menu. To access the Outline Pane, choose outline from the BigPicture Ribbon.

Enter in the Outline

- Open the Outline Pane by clicking the **Outline** button on the BigPicture ribbon. *(See #1)*

- Click on the **Show Connectors** option at the bottom of this pane to list all connectors. *(See #2)* - Connectors will appear in the outline with an arrow icon to the left of their name. *(See #3)*
Type the label you want directly in the Outline, then <Enter> or click in the worksheet itself. The label will be applied to the connector automatically.

NOTE: When in edit mode you can use the <Enter> key to add labels to connectors and topics as you go through the list in the outline.

Right-click in the Outline

- Open the Outline Pane by clicking the **Outline** button on the BigPicture ribbon. *(See #1)*

- Click on the **Show Connectors** option at the bottom of the Outline Pane to list all connectors. *(See #2)*

- Right-click a connector to open the BigPicture shortcut menu and choose **Connector Label** *(See #3)*

- Select **Custom Label** *(See #4)* to enter your own label, use any of the other label options that BigPicture provides, or choose the **Label** command *(See #5)* to link the Label name to a specified cell.
Choose a label type and then a label

After you have selected your connectors and chosen one of the methods above, you can choose your own label or you can select from built-in BigPicture groups of labels. Here are some examples of what the built-in labels have to offer.

Custom Label

Choose **Custom Label** and start typing.
Math
Relation

Events
Level
How do I change the default topic or connector shape to use in all my maps?

BigPicture topics and connectors default to a certain shape. (In this discussion, "shape" refers to the shape, border and background colors, style, font, and placement of text.) In any map, you can change the shape of any topics or connectors by selecting them and using BigPicture and/or Excel tools. However, you can also change the BigPicture defaults from the Application Settings dialog box. Then all map topics or connectors will have this new shape.

View default shape

Here are the default shapes for topics and connectors. Again, they include not only the shape and colors, but the font and label placement in the topics. Any of these defaults can be changed.

Open the Application Settings dialog box

1) Select Application Settings from BigPicture's Utilities drop-down list to open this dialog box.

2) The Topics and Connectors sections determine the default shapes.

Note that if a map already exists, changes to these application settings won't affect existing topics or connectors, but they will apply to new topics and connectors in the current map and in future maps.
Change the default topic shape

Create a desired topic shape

Starting from any shape (which could be an Excel shape or a BigPicture topic), modify it as you like.
Open the Application Settings

Click `<select shape>` to the right of the **Default Shape** *(See #1)* option and then click the ellipsis button *(See #2)*.

![Application Settings dialog box](image)

Select the desired shape

From the resulting dialog box, select the desired shape. Its name appears in the box. Then click OK.
Accept the change

When you click OK in the Application Settings dialog box, you are asked if you really want to make this change. If you do, click OK.

Create a new topic

Add a new topic to an existing map, or add a topic to start a new map. In either case, the new topic will have the new shape.
Change other default topic properties

Again using the Application Settings dialog box, you can change two other default topic properties.
Show label only

This setting can be toggled to Yes or No, with the following effect.

Picture position

If you right-click a topic and select the option **Add Picture**, this application setting determines whether the picture is in the left part or the right part of the topic. Here is an example where the position has been changed to "right."

Change the default connector shape

Create a desired connector shape

Starting from any connector (which could be an Excel shape or a BigPicture connector), modify it as you like.

Open the Application Settings Dialog

Click <select connector> *(See #1)* and then the ellipsis button *(See #2)*
Select the desired connector

From the resulting dialog box, select the desired connector. Its name appears in the box. Then click OK.

Accept the change

When you click OK in the Application Settings dialog box, you are asked if you really want to make this change. If you do, click OK.
Create a new connector

Add a new connector to an existing map or a new map. In either case, the new connector will have the new shape.

![Diagram of a new connector](image)

Change other default connector properties

From Application Settings, you can also change several other default connector properties in the obvious way. Remember that a connector label is a text box with text or a symbol that is placed on a connector. Unless you change the Always Label Connectors property, connector labels are optional.
Click Reset to return to original settings

You can always click the Reset button at the bottom of the Application Settings dialog box to return to the original default settings.
How do I utilize conditional formatting with linked cells?

BigPicture's Link to Cell Formatting feature in conjunction with Excel's conditional formatting feature can add another dimension to any of your maps. By applying conditional formatting to your data and maps, you can quickly identify variances in a range of values with a quick glance. The following examples will demonstrate how this powerful combination can be used in free form maps, data maps and organizational charts.

*The Conditional Formatting in Excel steps below show you how to use Excel's built in conditional formatting tools. Please note that you can also utilize BigPicture's ability to link topics to manually formatted cells. (i.e. cells that have been formatted with Excel's standard fill options)*

**Conditional Formatting in Excel**

For those whose may not be familiar with how to utilize Excel's conditional formatting feature. Here are the basic steps to get you started.

- Select the data that you want to conditionally format
- Click on Excel's Home tab
- In the Styles group click the arrow next to Conditional Formatting, *(See #1)*
- Click Color Scales and choose the color scale that you would like to use. If you would prefer to have icons or data bars appear in your BigPicture Topics, you can choose from those options as well.

**NOTE**: In some versions of Excel, you can gain quick access to conditional formatting by clicking on the contextual icon that appears after you have made a selection in Excel.

Once you have acclimated to the basic conditional formatting, you can experiment and add some advanced features using the New Rule...and Manage Rules... options.
Conditional Formatting in Free Form Maps

Once you have conditionally formatted your cells, BigPicture can color topics with that conditional formatting by utilizing the **Link to Cell Format** command. This command picks up both conditional formatted cell colors, as well as conditional formatted icons, and displays them in linked topics. When the data is changes, the Topic color and icons change.

When working with a free form map, there are two ways to access the **Link to Cell Formatting** command: Via the Topic Pane and Via the Right Click Menu.

**Via Topic Pane**
- Click on the topic that you would like to link to cell formatting *(See #1)*
- Click on **Topic** in the **View** section of the BigPicture Ribbon *(See #2)*
- Open the **Format** section in the Topic Pane *(See #3)*
- Click in the box to the left of **Link to Cell** *(See #4)*
- Manually enter the cell reference in the Use Format from Cell box or click on the icon to the right to select the cell in your worksheet. *(See #5)*
Via Right Click Menu

- Right click on the topic that you would like to format
- Click on **Format>Link to Cell Format** *(See #1)*

A dialog will appear *(See #2)* Manually enter the cell that you would like to reference, or click the cell in the worksheet.
Conditional Formatting in Org Charts

Conditional formatting in Org Charts can allow you to visualize your data at a quick glance. Does your company have to cut labor costs or reshuffle some employees? With BigPicture you can color code your Org Chart based on salary to see whom is overpaid for their level in the company. Or color code it base on performance to see whom is excelling in their position? Or create a new column of data that you can conditionally format that ties together cost of living factors, salary and performance ratings.

The first image below shows how an example file looks with the Rating column conditionally formatted. *(See #1)* The second picture shows what the corresponding Org Chart will look like. *(See #2)* There is no special setting - BigPicture does the work for you.

BigPicture 2016 Manual
by coloring the associated topic based on the attributes of the **leftmost cell in a particular row** that has formatting assigned to it. Once an Org Chart is made, and a value in the column that has conditional formatting is changed, the appropriate topic color and icon will be updated in the chart by simply pressing the [F9] key.

Conditional formatting icons can also be used in Org Charts. The Conditional formatted icons will appear in the topics if they are assigned as a conditional format option in the corresponding cell. (See #3)

NOTE: Because BigPicture is set to color code the topic based on the leftmost formatted cell for any particular row, you can color code base on different columns of data for different situations in your data set. For instance you could conditionally format your upper management based on performance and the remaining staff could be conditionally formatted based on salary.
Conditional Formatting in Data Maps

Data Maps can also show conditional formatting. End topic tables will pick up cell colors from the original data set and display the colors on the appropriate entries in the end table. If you choose to display end topics as individual topics, conditional colors and icons will be carried over to the map.

Similarly to Org Charts, there is no special setting to do this. BigPicture does the work for you by color coding the topic based on the attributes of the leftmost cell in the associated row that is formatted.
How do I connect multiple topics to an additional parent topic?

There may be times when you would like to connect an additional parent topic to multiple children topics that already exist. The following steps will demonstrate how to do so via two different ways:

<ALT> Select and Move Method

Select the topics you would like to move by <SHIFT+Clicking> the individual topics, or alternatively, if you plan on moving a Parent Topic along with its Children Topics you can simply depress the left mouse button on the Parent topic for an extended amount of time and it will include the children in the move. If you choose to select multiple topics by <CTRL+Clicking>, when you go to move the topics, a duplicate set of topics will be created.

Once you have selected the appropriate topics:

- Hold the <ALT> key down and click and hold the left-mouse button down on a topic for a bit.
- BigPicture will go into a mode that allows you to move the topic and connect to a different topic. You’ll see the topic that you clicked on temporarily change color when it’s in this mode.
- Move the topics around with the mouse down, notice that the the red square changes and highlights the closest available connection point on other topics.
- Release the mouse when the desired red square site highlights. Note that the original parent connections will be maintained in addition to the new parent connections.

Note: <ALT> only matters when starting the move. Once the topic changes color you can release the <ALT> key.

Via the New Parent Topic Command

Select your topics that you would like to link to a new Parent Topic. You can do this by either <SHIFT+Clicking> the individual children topics or you can click on the original
Parent Topic and use the **Select>Only Children of Selected Topic** option from the BigPicture ribbon.

**Select Topic Tools > Connect Topic(s) to New Parent**

After you have selected your children topics, select **Connect Topic(s) to New Parent** option from the Topic Tools drop down menu.
Click on the New Parent Topic

A Select Topic dialog will appear. Simply select the New Parent Topic that you would like to connect the selected topics to, then click OK. In this example we will select the 'Parent 2' topic.

Select Yes to add as an additional parent topic

BigPicture with display a dialog that gives the option to select Yes to add as an additional parent topic or No to move the connectors to the new parent. See examples below and note the differences.
Option: Change colors of New Parent's connectors

While the New Parent Topic is selected:

- Choose **Select > Select Topic and Children**
- Choose **Select > Only Connectors between Selected Topics**
- Click on Excel's Drawing Tools **Format Tab** and change the color of the lines via the **Shape Outline** dropdown menu.
How do I change the direction of a connector?

To change the direction of a connector between topics, right-click on the connector and choose Change Direction from the BigPicture pop-up menu.

Right Click on the connector, choose Change Direction

If you would like to change the direction of more than one connector at a time, <CTRL+Click> on the connectors then right-click on any of the selected connectors and choose Change Direction from the BigPicture pop-up menu.

In the example below, we have selected all three of the connectors that are pointing from the Parent Topic to the respective Children Topics. Note that in the resulting map the connectors are pointing from the Children Topics to the Parent Topic.

NOTE: This differs from simply changing the appearance of the connectors (i.e. having the arrow on one end or the other). This allows BigPicture to expand and collapse in the direction of the connectors.
How do I add Boundaries around my topics?

BigPicture has the ability to Attach Shapes to your existing topics. The first is the Attach Shapes > Boundary command which allows the user to "group" related topics together by adding a Boundary shape. This command will help you add some additional pizzazz to your maps!

Select Topics and choose Boundary Command

To add a Boundary shape to a selection of topics:

- Select the topics that you would like to "group" together
- Right click on one of the selected topics
- Choose the Attach Shapes > Boundary > Add New command *(See #1)*

By utilizing the Boundary command a default shape will be placed behind the selected topics *(See #2)* and will move and re-size with the topics.

* You can also access this command from the Topic Tools icon in the BigPicture ribbon.

NOTE: To remove a boundary, just delete the shape in Excel by clicking on it and press your Delete key on your keyboard.
Boundary Options

After you have added your boundary, there are a variety of options at your disposal.

- Customize your boundary shape by utilizing Excel's standard capabilities of changing the color, shape effects, size, font, text, etc. - Right click on the shape and choose Fill from the Excel popup menu. *(See #1)*

- If you decide to move one of the topics in the boundary shape, the shape will re-size automatically. *(See #2)*

- A boundary can be placed around a single topic. *(See #3)*

- Boundaries can overlap. *(See #4)*

- Multiple boundary shapes can be added to the same topic, or group of topics. All of which can be moved and re-sized. *(NOTE: To access any boundaries that may be hidden behind another one, right click and utilize the Send to Back and Bring to Front commands from the pop-up menu.)*

- Boundaries can be manipulated so that they do not surround the topics - yet will still collapse and open with the topics that they have been "bound" to. *(See #5)*
Edit which topics are included in a Boundary

- Click on a Topic in the group that has the boundary that you would like to edit.
- Right-click and choose **Attach Shapes > Boundary > Edit Existing** command. A dialog will come up that lists the topics that are currently included.
- To add topics click on the topics that you would like included in the boundary shape. **NOTE:** You must select **ALL** of the topics that you would like included in that boundary, not just the new ones.
- If you would like to remove a topic click on any of the white space in your spreadsheet to clear the listing and then select only the topics that you would like included in your boundary.
Reuse the style of a particular Boundary shape

If you would like to use the same style boundary shape that already exists in your map:

- Select the topics that you would like to add a boundary to FIRST.

- Choose the **Attach Shapes > Boundary > Copy Existing** command. At this point a dialog will appear asking you to select the Shape that you would like to copy.

- Click on the existing Boundary shape or attached custom shape that you would like to duplicate.

- Click OK.
How do I attach Custom Shapes?

BigPicture has the ability to Attach Shapes to your existing topics. There are two commands under the "Attach Shape" category. The first is the Attach Shapes > Boundary command which will typically be attached to a group of related topics. The second is the Attach Shapes > Custom command that would be more applicable with a single topic. This is simply a way that you can add Excel shapes to the selected topic(s). These commands are incredibly flexible and will help you add some additional pizazz to your maps.

By utilizing the Custom command a default light yellow callout shape will be attached to the selected topic(s) and will move with the topic(s).

Select the topic and choose the Attach Shapes > Custom Command

1. The default light yellow callout shape will appear above top-most topic selected.

2. You can customize your shape by utilizing Excel's standard capabilities of changing the color, shape effects, size, font, text, etc.

3. If you decide to move the topic(s) that the custom shape is attached to, the shape will move also.

4. Custom shapes can overlap.

5. Multiple custom shapes can be added to the same topic, or group of topics. All of which can be moved and re-sized. (NOTE: To access any custom shapes that may be hidden behind another one, simply right click and utilize the Send to Back and Bring to Front commands from the pop-up menu.)

6. If you collapse (hide) any of the topics that the shape is attached to, the shape will collapse (hide) with it.

7. A custom shape can be to a single topic or multiple topics.

NOTE: To remove a custom shape, just click on the shape and hit your delete key on your keyboard.
Duplicate an existing shape

If you would like to use the same style custom shape (or any other existing "non-BigPicture" Excel shape) that already exists:

- Select the topic(s) that you would like to add that custom shape to FIRST
- Choose the Attach Shapes > Custom > Copy Existing command.
- At this point a dialog will appear asking you to select the shape that you would like to copy. Click on the existing shape that you would like to duplicate.
- Click OK.
Selecting and Moving Maps

What are the Select options, and why do I need them?

Select options make it easy for you to select multiple topics at a time without having to individually click on them. You typically choose one of these for moving or formatting all or part of a map. For example, you might want to change the font size or color background of all, or some, of the topics.

Select Options

There are five possible Select options. These options can be accessed via the Select menu in the BigPicture Ribbon (See #1) or via the right-click menu on a Topic. (See #2)

All Topics

When utilizing the All Topics selection command, BigPicture will select all of the topics AND the connectors. This is great to use if you want to move the entire map to a different
location on your worksheet, or if you would like to add or change the style or color of all of the topics and their connectors.

*TIP:* If you would like to select all of the connectors in your map you can start with this command and then immediately choose the **Only Connectors Between Selected Topics** command.

**Selected Topic and Children**

This item was chosen while Topic 3.

*Note that the connectors from Topic 3 as well as those from its children are now selected.*
Selected Topic and Parents

When the user clicks on Topic 7 and then chooses **Select Topic and Parents**, BigPicture will select the topic itself as well as the topics that are Parents of the selected topic.
Only Children of Selected Topic

This item was chosen while Topic 3 was selected. Now neither Topic 3 nor the connectors from it are selected, just the children of the Topic 3 and their corresponding connectors are selected.
Only Connectors Between Selected Topics

Starting from the map shown in the Selected Topic and Children section above, this item produced the following.

Now *only* the connectors are selected, not the topics. For example, this might be useful if you want to change the color or other properties of certain connectors.
Select by clicking

Alternatively, you can select any combination of topics and/or connectors in the usual Excel way: by clicking them, one at a time, while holding down the <Ctrl> or <Shift> key.

Note: If you hold the <Ctrl> key down while moving one of the topics, BigPicture will duplicate all of the topics selected.
How do I move an entire map?

Select all topics

From the Select drop-down list on the BigPicture ribbon, select All Topics.

Move the map

Now the entire map is selected, including topics and connectors, and you can move it to a new location on the sheet by dragging it.
Moving and Reconnecting Topics

Easily move and reconnect topics

Our developers have added some functionality to make it easier to move topics and connections in non-auto generated maps.

If you hold the left-mouse button down on a topic for a bit, BigPicture will go into a mode that allows you to move the topic (and optionally, its children) and connect to a different topic. You’ll see the topic temporarily change color when it’s in this mode. Then, when moving topics around with the mouse down, the red square highlights the closest available connection point on other topics. When you release the mouse it connects to that red square connection site.

You can move and reconnect more than one topic at a time:

Hold the <SHIFT> key down while clicking on the various topics that you would like to reconnect elsewhere. After you have all of the topics selected, hold the left-mouse button down on one of the selected topics and move/reconnect it as you would with just a single topic.

If you would like to move and reconnect a group of topics that is made up of a parent topic and corresponding children topics, see the next item below.

Move and Reconnect Multiple Topics that are Connected to a Parent Topic

If you would like to move a group of topics that is made up of a Parent Topic and its Children Topics:

- Simply depress the left mouse button on the Parent Topic for an extended amount of time and it will automatically include the children in the selection

- BigPicture will go into a mode that allows you to move the topic and connect to a different topic. You’ll see the topic that you clicked on temporarily change color when it’s in this mode.

- Move the topics around with the mouse down, notice that the red square changes and highlights the closest available connection point on other topics.
- Release the mouse to connect to the current red square connection site.

Alternatively, to expedite the amount of time it takes to have it automatically select the children topics, you can also hold the <SHIFT> key down and click on the Parent Topic to let BigPicture know you would like the Children Topics included in the move.

Note: <SHIFT> only matters when starting the move. Once the topic changes color you should release the <SHIFT> key. If you continue to hold the <SHIFT> key down while moving the topics, it will constrain the move to be only horizontal or vertical.

Ability to connect multiple topics to an additional parent topic

Utilizing the above instructions for easily moving and reconnecting a topic(s) you can also opt to have the topics that you are moving connect to an additional parent topic by holding the <ALT> key down at the start of the move.

Pressing <ALT> maintains the existing connection while adding a new one at the red "hotspot" of your choice.

Note: <ALT> only matters when starting the move. Once the topic changes color you can release the <ALT> key.
What are the expand and collapse buttons?

The green "plus sign" and red "X" buttons next to topics let you expand or collapse all children of that topic. These buttons can be useful when you would like to temporarily hide or expand a portion of your map.

Expand buttons indicate that some topics are currently hidden

When topics have been collapsed, you see the green "plus sign" buttons. You can click any of them to expand the hidden topic(s).

Collapse buttons indicate that topics emanating from that topic can be collapsed

The red "X" collapse buttons don't appear automatically, but if you hover the mouse over a topic that has topics emanating from it, you will see the collapse button. Then you can click it to hide all the direct or indirect "children" of the topic.
Notes, Markers and Tags

What are notes, and how do I create them?

A note is a text box where you can add descriptive information about a topic.

Add notes

The note shown here is typical. There are three ways you can add a note.
Method 1: Right-click a topic

- Right-click on a topic. This opens the usual BigPicture shortcut menu,
- Click on Add Note from the Note option.
- Type your description in the note.
Method 2: Use the Outline pane

- Click on the Outline button in the BigPicture ribbon to open the Outline view (if it isn't already open).

- Right-click on the topic name that you would like to add a note to.

- Select Add Note from the Note option in the pop-up menu.
Method 3: Use the Topic pane

- Click on the Topic icon in the BigPicture ribbon to open the Topic view (if it isn't already open).
- Click on the Note option and check the Include Note option.
- Type your note in the field provided.
BigPicture will add the Note to the selected Topic

Note settings
Once a note exists, the shortcut menu allows you to delete the note, keep the note open, or show all notes.
Note indicators

If you decide not to keep a note open, you can still see that a note exists by the note icon below the topic. You can click this icon to see the note, and click again to close it.
What are markers, and how do I create them?

Markers provide additional information about topics, and they appear as icons below topics. You can add more than one marker to a topic.

Adding Markers

Markers can be added in a variety of ways most of which will bring up a dialog that looks like the following. Note that this example shows how three different markers can be added to one topic.

The articles below cover how to add markers using the following methods.

- Via Right-Click
- Via Marker Menu
- Via Outline Pane
- Via Topic Pane

NOTE: To remove a Marker from a Topic, select it in the Markers dialog and use the <Del> key on your keyboard.
Via Right-click

To add a marker to a topic you can right-click on the topic and select Markers from the BigPicture pop up menu. This will bring up the Markers dialog shown in the image above. Simply click in the cell to the right of the List Name and click on the drop down arrow to view a listing of markers associated with that particular list. As soon as you click on the name of the marker, it will be added to the topic.

The Markers window will remain open, allowing you to click through your map to easily add markers. To close the dialog, click the Close button.

NOTE: You can add markers to multiple topics at one time by selecting the topic(s) using the BigPicture selection tools, or by <CTRL+Click> or <SHIFT+Click>, then choose your markers from the Markers dialog.
Via Markers menu in Ribbon

Similarly to adding markers via the right click option, you can do the same steps with the Markers option in the ribbon.

- Select **Markers>Add Markers...** from the BigPicture Ribbon. (See #1)
- This will bring up the Markers dialog.
- Click in the cell to the right of the List Name and click on the drop down arrow (See #2) to view a listing of markers associated with that particular list. Click on the name of the marker, it will immediately be added to the topic.

The Markers window will remain open, allowing you to click through your map to easily add markers to other topics. To close the dialog, click the Close button.

**NOTE:** You can add markers to multiple topics at one time by selecting the topic(s) using the BigPicture selection tools, or by <CTRL+Click> or <SHIFT+Click>, then choose your markers from the Markers dialog.

Via Outline Pane

You can add Markers directly from the outline in the Markers View. Note that if you have Markers already assigned to some topics, those Markers will be listed and the Topics that
are assigned to that particular Marker will be listed below it. Topics that do not have a Marker assigned to them yet, will appear in the No Markers section of the outline. (See #1)

Add a Marker via Right Click

- Right click on the topic name in the outline that you would like to add a Marker to
- Select Markers in the pop up menu
- Choose the Marker option that you would like in the Markers Dialog window.

Add a Marker via Drag and Drop

Any topics that do not have a Marker will appear in the No Markers section of the outline.

- Click on the Topic(s) that you would like to add a Marker to. When you click and begin to drag, a blue triangle will appear. (See #2)
- Drag and drop it onto the Marker that you would like to assign to it. (See #3)
- BigPicture will automatically assign the Marker the Topic(s) in the map. (See #4)

**NOTE:** If the Marker you are looking for does not exist in the outline because it has yet to be assigned to a topic, you can add a placeholder (blank) Marker to your outline by clicking on the Gear icon (See #5) and selecting the Marker(s) that you would like to add. As soon as you click on the Marker name in the dialog, it will automatically be added to the outline so that you can drag and drop the topics onto the Marker names.
Via the Topic pane

- Click on the **Topic** button in the View section of the BigPicture ribbon (See #1) to display the Topic pane to the right of your workbook. (See #2)

- Click on the desired topic in the map to select it. (See #3)

- Click on the **Markers** option in the Topic Pane (See #4)

- Next to the desired marker list, click in the Marker column and use the drop-down list to select a marker. (See #5)

- Your selected marker will appear to the lower-right side of your Topic (See #6)

*Note: If you would like to use one of the markers as a picture inside the topic, you can do so by clicking on the **Change Marker to Picture** button. (#7)*

To delete marker select it in the marker list and click the **Delete Marker** button.

Another example of this can be seen in the **How do I add pictures to topics?** help article.
Add your own marker list

BigPicture includes some built-in lists of markers, however you can add your own custom markers to suite your needs. Be sure to follow the following steps to see to it that your custom markers are added properly.

- Enter the name of your new marker list in a cell
- Directly below the name of the list, enter the marker names
- Import your pictures into Excel, placing each of them in the cell to the right of their names (See #1)
- Click on the Markers icon in the BigPicture Ribbon

- Select Manage Markers...

- Click on the Excel selection icon in the upper right corner of the Manage Markers dialog (See #2)

- Select the two columns that have your marker images and titles (See #3)

- Click OK

- The Manage Markers dialog will appear. If you would like your custom markers to be used in other maps, click on the Save As Default button. (See #4) If you would prefer that they only be used in the current workbook, you can click the OK button.

- Your new Marker list will now appear in the Markers dialog. (See #5)

**HINT:** If you have a variety of Marker List ideas that you would like to have available to you, create a worksheet that has all of your custom markers in it and repeat the above steps for each list in your worksheet being sure to choose Save As Default. This will ensure that your custom markers are always available.

For additional practice with creating custom markers, you can also reference the Adding Markers and Marker Lists.xlsx Example Spreadsheet included with your download.
How do I change markers to pictures?

A marker on a topic is a small icon shown slightly below the right side of the topic. You might prefer the marker to appear as a picture inside the topic. This is easy to do and is explained here.

Add markers.

Start by adding markers, such as national flags, to topics. Adding markers is explained here.

Show the Topic pane

Click the Topic button in the BigPicture ribbon to show the Topic pane on the right side of the Excel window.
Change Marker to Picture via the Topic Pane

1) Select a topic.

2) Expand the Markers section of the Topic pane.

3) Click the Change Marker to Picture button.

Repeat for Other Topics

Repeat this for any other topics where you want pictures instead of markers. Here are the results.
What are tags, and how do I use them?

Tags are used for placing topics or connectors in groups, like marking the topics whose importance is "high" with a text indicator that shows the tag. Tags can be placed on topics and connectors. They are similar to Markers in that they come in groups (like "Progress" or "Importance") with a set of possible items in each group. For example in the "Importance" group there are items such as "Low", "Medium" and "High". All of which have their own distinct attributes.

Tags appear as text in a small box above a topic and they also have formatting information associated with them including color, shading and shape attributes. Each tag type has separate formatting that can be specified for the Topic, Connector and the Tag shape itself. This allows you to apply common formatting to all topics that share a common tag value, which in turn helps to maintain consistency when you are working with multiple maps.

*NOTE: When a topic has multiple Tags, the Topic Text will include all of the Tags, however the formatting of the topic itself will be based on the first Topic assigned.*

How to Add Tags to Topics

Tags can be assigned to a topic in a variety of ways:

- Via right click menu
- Via the Tags menu in the Ribbon
- Via the Topic Pane
- Via the Outline Pane

Via right click menu

- Select the topic(s) that you would like to tag - Note that you can tag more than one topic at a time.
- Right click on one of the selected topic(s)
- Select Tags from the BigPicture pop up menu (*See #1*)
- Choose the tag option that you would like. For this example we have chosen the Importance - Low tag. (*See #2*)
NOTE: BigPicture automatically applies the formatting attributes that are assigned to the Importance [Low] Tag in the Tags Format Worksheet. (See #3)

You can access the Tags Format Worksheet via the BigPicture Ribbon>Tags>Tag Format Worksheet.

Once the Tags Dialog is open you can then click other topics to add tags to them.

Via Tags menu in the Ribbon

- Select the topic(s) that you would like to tag - Note that you can tag more than one topic at a time.

- Select Tag>Add Tags... from the BigPicture Ribbon

- Choose the tag option that you would like. For this example we have chosen the Importance - Low tag. (See #2)

NOTE: BigPicture automatically applies the formatting attributes that are assigned to the Importance [Low] Tag in the Tags Format Worksheet. (See #3)

You can access the Tags Format Worksheet via the BigPicture Ribbon>Tags>Tag Format Worksheet.

Once the Tags Dialog is open you can then click other topics to add tags to them.
Via the Topic Pane

- Select the topic that you would like to tag
- Open the Topic Pane via the Topic icon in the View section of the BigPicture Ribbon (See #1)
- Click on the Tags arrow to expand the Tag section of the Topic Pane (See #2)
- Choose the tag option that you would like. For this example we have chosen the Importance - Medium tag. (See #3)

NOTE: BigPicture automatically applies the formatting attributes that are assigned to the Importance [Medium] Tag in the Tags Format Worksheet.

You can access the Tags Format Worksheet via the BigPicture Ribbon>Tags>Tag Format Worksheet.

Once the Tags section in the Topic Pane is open you can then click other topics to add/edit tags.
Via right clicking in the Outline Pane

You can utilize the Outline Pane to add/remove Tags from Topics and group Topics based on their Tags.

- Open the Outline Pane via the Outline icon in the View section of the BigPicture Ribbon (See #1)
- Click on the Tags icon to open the Tags View of the Outline Pane (See #2)

NOTE: Any topics that are not yet tagged will appear in the Not Tagged section of the outline. (See #3)

You can add Tags directly from the outline in the Tags View - which is demonstrated below (See #2), Outline Mode (See #4) or Marker Mode (See #5), as well.

- Right click on the topic name in the outline that you would like to tag
- Select Tags in the pop up menu (See #6)
- Choose the tag option that you would like in the Tags Dialog window.
In addition to viewing your Topics grouped by their Tag type as shown below, you can utilize the Options dialog (See #7) to set up Summary views. For example you could view which topics have High Importance and are only at 20%. To explore this in greater detail, view the Tags Outline View Features article.

Via drag and drop in the Outline Pane

You can utilize this functionality if there have already been tags assigned elsewhere in your map.
The Outline Pane has the ability to group topics based on their Tags.

- Open the Outline Pane via the Outline icon in the View section of the BigPicture Ribbon (See #1)
- Click on the Tags icon to open the Tags View of the Outline Pane (See #2)

Any topics that are not yet tagged will appear in the Not Tagged section of the outline.

- Click and hold mouse button down on the topic that you would like to tag (See #3)
- Drag the topic to the Tag type that you would like to assign to it. (See #4)
- When you release the mouse, the name of that topic will appear in the group that you assigned it to and the correct formatting will automatically be assigned. (See #5)

How do I add Tags to Connectors?

You can add a Tag to a connector via the Tags dialog.

- Right click on the connector(s) that you would like to tag
- Select Tags (See #1)
- Choose the tag option that you would like. For this example we have chosen the Low Importance tag. (See #2)

NOTE: BigPicture automatically applies the formatting that is assigned to the Importance [Low] Tag in the Tags Format Worksheet. (See #3)
You can access the Tags Format Worksheet via the BigPicture Ribbon>Tags>Tag Format Worksheet.

How do I Format a Tag?

Tag formatting is specified in the "Tag Formats" worksheet. This can be shown and edited by the user using the View Tag Formats Worksheet.

- Click on the Tags icon in the BigPicture Ribbon.
- Select View Tag Formats Worksheet. (See #1)

If you haven't added your own tags, this worksheet contains some default Tags and formatting. (See #2)

The shapes in the worksheet can be changed to any desired Excel shape type or formatting. After you have finished formatting, click on the Close Tag Formats Sheet link in the top right corner of the worksheet.

Select Refresh Tag Formats (See #3) from the BigPicture Tags menu to update the tagged topics and connectors in the map to reflect the new formats.

NOTE: This worksheet shows shapes for all Tags the user has selected with Include Formats? in the Manage Tags dialog.
Built in Tags for Org Charts, Data Maps and Converted Decision Trees

BigPicture comes with some built in tags for Org Charts, Data Maps and Converted Decision Trees. If you have a preference in the way you would like to have those maps look, you can change their appearance by clicking on the Tags icon (See #1) in the BigPicture Ribbon and selecting View Tag Formats Worksheet. When you have finished editing the format simply click on the Close Tag Formats Sheet (See #2) link, located in the upper right corner.
How do I add my own Tags?

To set up your own Tag groups and items:

- Click on **Manage Tags** from the Tags menu in the ribbon. *(See #1)*
- Click on the green Add icon to the right of the group names to add a new group. *(See #2)*
- Click on the green Add icon to the right of the Tag Names box to add individual Tags. *(See #3)*

If you simply click **OK** these tags will be available for this map only.

If you click **Save As Defaults** your new Tags will be available for all of your maps.

The Tags Format Worksheet will open. Scroll to the bottom of the worksheet and you will find your new group of Tags. At this point you can edit them accordingly.
How do I clear a Tag from a Topic?

To clear a tag from a topic, select the topic, right click and select Tags. When the Tags dialog opens, click on the Tag that you would like to remove and click on the red [x]. (See #1) Close the window when you have finished. Your map will update accordingly.

NOTE: The Tag will be removed, however, if there was a color format associated with the tag, the formatting will remain until you change it to another color.
Tag Options

Hide Tag Text for Groups

You can choose to hide the tag text box for specified tag groups, or you can choose to change the global options for Tags. *(See Global Tag Display Options below.*) When choosing to **Hide Tag Text** for a specific Group of Tags, please note that the color and shape formatting to the topic will still display as specified in the Tag Formats Worksheet. However, the actual Tag Text and the Tag Text Box will remain hidden.

To hide Tag Text for Groups:

- Click on a Topic that is tagged with the Tag Group that you would like to hide.
- Choose Tags>Manage Tags from the BigPicture Ribbon.
- Click on the Group Name and put a check in the box under **Hide Tag Text?** *(See #1)*
- Click **OK** to apply this setting to only the current map. Click **Save As Default** if you would like to save that particular setting globally.

NOTE: Connectors can have tags too, but the tag text is never visible. Connectors just use the formatting specified for the tag.
Global Tag Display Options

You can choose to change your Map Setting to have Marker and Tags always display, display for only selected topics, or be kept hidden.

To do this, click on Map Settings>Display Markers and Tags

Then choose your preference.

The shape/color attributes for Tags will always continue to display for any of the options chosen. However, the actual "tag" that gets placed above the topic is what can be always shown, shown only when the topic is selected, or it can be hidden all the time.
Saving Tags as default for future maps

To set your default tag lists for your maps, open the Manage Tags dialog, make your adjustment and then click on the Save As Default option so they can be used with any future maps.

![Manage Tags dialog](image)

---

**Slide Shows**

How do I create a slide show?

Once you have created a map, BigPicture allows you to create a slide show where the map unfolds in any way you like. This is especially useful if you are presenting the map to an audience and you want to explain it in steps. BigPicture also allows you to create a textbox for each slide that explains that slide.

You can Ctrl+click the following link to watch a video about creating slide shows:

Creating a Slide Show Video

Understand the goal
Before explaining the steps for creating a slide show, it is useful to see a completed slide show.

The map
This is a map for a capital budgeting optimization model.

Slide 1
Now you see the results of playing the slide show.
For each potential investment, the company must decide whether to invest or not, and this is implemented with 0/1 variables.

The decisions and the given investment costs determine the total cost of the investments, which must remain within the budget.

The decisions and the given investment NPVs determine the total NPV, which is the objective to maximize.
Stop the slide show

You can press the Stop button on the BigPicture ribbon to stop the slide show at any point and return to the full map.

Create the Slide Show

Creating a slide show with BigPicture is very easy, especially if you make the "usual" choices. However, BigPicture lets you tailor your slide show in many ways to meet your needs.

Click the Slide Show button on the BigPicture ribbon

This brings up the **Define Slide Show** dialog box, with two tabs. This is where you make all of your choices.
Define Slide Show - Slide Tab

1) Click the Add button. This adds a first slide.

2) The added slide has a generic name, Slide #1 (which you can change by typing in the Slide field).

3) All Prior Slides, is selected by default in the list of Inherit Topics options (located at the bottom of the dialog). This option means that as the slide show plays, each slide will show its new topics, as well as all topics from previous slides. This is the way the capital budgeting slide show evolved, and it is probably the option you will use most often.

The other two options allow other possibilities. For example, if slide 1 shows topics 1, 2, and 3, you could use the last option to ensure that slide 2 shows topics 1, 4, and 5. The choice is totally up to you.
Click the SelectTopics for Slide button and check topics for slide

This opens the right pane on the dialog box, where you can select the new topics to show for that slide. By default, the topics are listed in a treeview (hierarchical) order. You might prefer a "straight list" of topics, which you can see by clicking the Left-Right Order button at the bottom. (If you do so, the button caption changes to Treeview Order, that is, this button is a toggle.)
Continue to add slides and select topics

In this case, three new topics are added to the second slide. But because of the All Prior Slides setting, the topics shown on the left for the second slide include the topic from slide 1. In any case, repeat this step as many times as necessary to define all slides. You can always use the delete and move up and down buttons to delete or rearrange slides.

(Optional) Play the slides defined so far

At any point, you can click the Play button to cycle through all the slides you have created so far. The button changes to a Stop button, and the slides continue to cycle until you click Stop.
(Optional) Start over

If you decide you have totally messed up, you can click the Clear All button to clear all slides and start over.

Choose options

You can choose a number of self-explanatory options from the Options tab. The Display Slide Description Boxes option is particularly useful, and it is discussed in some detail below.
Click OK

When you have finished defining slides, click OK to return to the map.
Create slide description textboxes

(Optional) Unhide the BP_SlideDescription sheet

The slide descriptions are stored on a hidden BP_SlideDescription sheet. You don't have to unhide and look at this sheet, but if you do, you can format the textboxes in which the descriptions appear. See the next step.
(Optional) Format the "template" textbox on the hidden sheet

The hidden sheet has a "template" textbox. You can use Excel's formatting tools to format this textbox any way you like. Then all of the slide description textboxes will be formatted this same way. After you have done this, you can rehide the sheet.

Format this box with the common color, shading, etc. you want to use for each slide description box.

Start playing the slide show

Click the Play button on the BigPicture ribbon to start playing the slide show. This button changes to three buttons, Previous Slide, Stop, and Next Slide for continuing.
Type a description and move the textbox

You will see the generic textbox, formatted as you specified, and you can type (or modify) a description for that slide. Note that if you move the slide (to make sure it is visible on the screen and won't overlap the map), the upper left corner of all other slide description textboxes will be in the same place. However, you can resize each textbox independently, depending on the length of the description.

Play the slide show

Play with the Play, Previous Slide, and Next Slide buttons

Click the Play button on the BigPicture ribbon to start playing the slide show. This button changes to three buttons, Previous Slide, Stop, and Next Slide for continuing.
Don't forget to click Stop

When you play the slide show, don't forget to click the Stop button. Most BigPicture options are disabled while a slide show is running.

Click Slide Show to modify the slide show

You can always click the Slide Show button to get back into the Define Slide Show dialog box and modify any part of the slide show, such as the order of the slides.
Data Maps

What is a Data Map and how do I create a Data Map?

A data map in BigPicture is a graphical analog of a pivot table in Excel. The goal of each is to break down data by category, or as many users say, to slice and dice the data. A pivot table shows the breakdown in a table, possibly accompanied by a pivot chart. A data map shows the breakdown in a map.

You can Ctrl+click the following link to watch a video about data maps:
http://www.palisade.com/BigPicture/Intro/EN/DataMaps/

Create an appropriate data set

The data set should be arranged similarly to the sales data shown here. (This is from one of the example spreadsheets under BigPicture Help.) Each column should represent an attribute, in this case of a sale, each row should represent a record, in this case a sale, and the top row should contain column headings. There will typically be categorical columns for breakdowns, and there will typically be numeric columns to summarize.

Create picture files

If you want the map to show pictures in topics, you can create picture files to associate with your data and store them in a folder of your choice. The names of these picture files should match the text in some column of the data set. In the above data set, for example, there could be pictures of the countries in column A, with names such as Argentina.jpg (or some other graphics file extension).
Fill in the Data Map dialog box

Click the Data Map item on the BigPicture ribbon to bring up the tabbed Data Map dialog box. Then fill it in as discussed in the following steps. They use the above sales data set for illustration.

Definition tab

In the Definition tab, you specify the data range and the columns to use for breakdowns. BigPicture calls these the grouped topics. In this case, sales will be broken down first by year, then by region, and then by product category. Each of these grouped topics will represent a "level" of the map. Typically, each of the grouped topics will have only a "moderate" number of categories.
End Topics tab

The End Topics are what you will see for each combination of the grouped topics. These can include categorical columns, such as Country and Product, and they can also include numeric columns for summarizing. In this example, totals (sums) of Units Sold and Profit will be rolled up to the grouped topics. For example, total profit will be shown for all 2012 Latin America sales of hair care products.

There are two Calculation Type options for categorical variables, in this case Country and Product. By default, the Summary option is chosen, which means that the map will show a summary by category in the End Table for this variable. However, if you don't want such a summary, you can choose "None" for the Calculation Type, as has been done here for Product.

There are several Calculation Type options for numeric variables: Total, Average, Min, Max and more. Also, there are two "Display End Topics in" options: Tables and Individual Map Topics. The Tables option results in a more compact display, and this is the option you will probably choose most often. Each End Table will include all entries in the data set that
share the same values for the grouped topic combination. For example, the 2012/Latin America/hair care grouping will include all rows that have these values in common.

Finally, you can check the bottom Rollup End Topic Count option to see the number of records (data rows) for each grouped topic in the map.

Pictures tab
To include pictures, check the Add Pictures option, and then select the folder where the picture files are stored and the field that matches the names of the picture files. Pictures can be added to grouped topics or to end topics or tables.
Markers tab

Markers are optional. They allow you to show extra information about each topic below the topic. In this example, country flags are shown. There are actually many marker types available, which you can choose from a dropdown list under Marker Type. For example, the All Countries type is a built-in type with flags for most countries.
Filters tab

A filter is also optional. It lets you include only a subset of all topics in the map. For example, you create a filter so that only sales in North America show in the map. To remove a filter, you simply uncheck the Pre-Filter box.
Display tab

The Display tab's default settings usually suffice, but you can change them to suit your taste. In this example, a descriptive name has been given to the map, each level of the map will be colored differently, and the map will be placed on a new worksheet in the same workbook as the data.
Check Data button

BigPicture checks your data sets to find and correct capitalization differences, spacing issues, some inadvertent misspellings, etc. that would keep your Data Maps from being generated properly. BigPicture matches entries in columns used for grouped topics, markers, supervisor names etc. when creating Data Maps. Small differences can cause entries from not being matched properly.

When creating a Data Map for the first time, it is recommended to click on the Check Data button to make sure that your data is set up properly. For any subsequent data maps that you make with that same data, it will not be necessary to click Check Data unless the underlying data has changed.
Create the data map

When you click the Create Map button, BigPicture creates the data map and performs any requested calculations. By default, the map shows the root (all sales) and the first level of topics, along with rollup calculations.
Expand (or collapse) any section of the map

You can click any of the green expand buttons to follow the map structure to the right of a topic. You can then click any of the red collapse buttons to collapse any part of this. Here you see some categories of all three grouped topics.
Expand further to see end tables

To see an End Table, expand any of the last level of grouped topics. Because two categorical columns were requested for the end topics, but Summary was chosen only for Country, not Product, the dropdown list in the table lets you see breakdowns by country (one row in the table for each country, as shown here), or by detail (one row for each country/product combination).

View end topics with the Individual Map Topics setting

If you choose Individual Map Topics in the End Tables tab, the result will be an individual topic for each country/product combination. Unless the number of end topic categories is quite small, an end table is probably preferable.
Modify or update the map

If you want a different map based on the same data set, you can go back into the Data Map Definition dialog box and change the settings. Then you are asked whether you want to overwrite this map or create a new map (on a new worksheet). The choice is up to you.
End Topics in Data Maps

This is probably the trickiest aspect of data maps. Your first step is to understand the concepts of a Data Map

Understand the concepts and purpose of a data map

Understanding the concept of a data map

Each data set provides a new challenge for creating a data map. The conceptual steps are straightforward and always the same:

1. Decide which columns you want to use for categorical breakdowns. This determines the grouped topics.

2. Decide the information you want for each combination of grouped topic categories. This determines the end topic settings.

Decide the purpose of a data map

Recall that the purpose of a data map is to break down data by categories, where the categories are those in the columns designated as grouped topics. The example used here is of Premier League soccer players. (This is one of the BigPicture example spreadsheets found from the Help dropdown list.)

Show the map with grouped topics only

The columns selected for grouped topics in this example are Team Rank and then Team. The section of the map showing only the grouped topics shows the various team ranks and the teams in any particular rank, here the highest rank group. However, this doesn't provide
much information without end topics. (The numbers in the topics shown here actually result from end topic settings, as explained below.)

Fill in the End Topics tab

This is where you specify the information you want to show in the end table. You can choose any combination of columns for the end topics: categorical, numeric, or distinct-value text such as Player. In the dialog, a + or # sign is often shown next to a row. For example, the + sign next to Position means that the end table will include averages over players in each position. The # signs next to the numeric columns indicate that they are candidates for summary measures, including rollups to the grouped topics. However, as the Value end topic row indicates, rollups aren't required, even if they make sense.

To understand these choices better, the following substeps show typical results from the map.
Calculation Types

BigPicture can calculate a variety of additional statistics on your data, show those statistics in End Tables and display them as rollup calculations in your Data Maps. These calculations include: Total, Min, Max, Average, Median, Mode, StdDev, AveDev, Variance, Range and Percentiles. *(See #1)*

In addition, you can calculate multiple statistics on the same column in your data set. *(See #2)* These statistics can be shown in End Tables and displayed as rollup calculations in your Data Maps.

All calculations are "live" and the Data Map and End Tables update when values in your data set change.
Summarize by a categorical end topic column

You can summarize for any end topic that has a plus sign next to it. (See #1) By choosing Summary in the Calculation Type column (See #2), it will create an additional View option in the Data Map End Topic Pane (See #3). The end table for the Everton team now shows averages for each position (See #4), and the team topic to its left shows the rollup calculations (averages over all positions) for Everton. (See #5)
Show detail

When you choose Detail in the View box of the Data Map End Table pane (See #1), the end table displays a row for each row in the data set corresponding to that grouped topic joint category. The end table now has a row for each Everton player, so the numeric values in the table are original data values, not averages as seen with the summary statistics in the above example. (The left two columns are requested markers.)
Tables versus Individual Map Topics

In the "Display End Topics in" box, you can choose Tables or Individual Map Topics. (See #1)

Depending on the size of your data set, if you choose the option to display end topics as Individual Map Topics, you may get the following message recommending that you select Tables instead. (See #2) If you go ahead anyway, you will get a separate topic for each player instead of a compact table. In an example like this one, with many players on each team, a table is almost certainly preferable.
End Topic Pane

Data map end tables will display in the End Topic Pane. This Pane allows you to keep all of your end topic tables in one location. You can choose to display only one table at a time or you can open multiple end tables to help you explore your data and compare different situations.

Display a Single End Table

You can display your end topics one at a time or you can click in the "Display Multiple Tables" box \textit{(See #1)} to display more than one end table at time.

If you choose to only display one table at a time, when you click on a green expander icon it will open that corresponding table in the End Topic Pane and will automatically close the one that was previously open.
Display Multiple End Tables

You can choose to display more than one end table at a time to give you the opportunity to explore and compare your tables with a quick glance. To do so, click in the box to the left of "Display Multiple Tables". (See #1)

*Note: The Expand/Collapse icon will toggle from the green expand icon to the red collapse icon for the most recent table that was opened. For all previous end tables that are open in the Data Map End Table Pane, the icon will disappear to help signify that it is already open.*

To close tables in the End Table Pane:

- You can click on the red collapse icon in the map if you would to close the most recently opened end table. (See #2)

- You can click on the [x] in the top right corner of the table that you would like to close. (See #3)

- You can close all of the end tables at once by clicking on the large grey X in the top right corner of the End Table Pane. (See #4)
### Data Map

**6 Tottenham Hotspur**
- Avg. Points: 62
- Avg. Salary (wk): £49,083.33
- # Players: 24

<table>
<thead>
<tr>
<th>Position</th>
<th>Avg. Points</th>
<th>Avg. Value (m)</th>
<th>Avg. Salary (wk)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Attack</td>
<td>84</td>
<td>£4.47</td>
<td>£73,323.33</td>
</tr>
<tr>
<td>2 Defense</td>
<td>58</td>
<td>£3.44</td>
<td>£25,250.00</td>
</tr>
<tr>
<td>3 Goalie</td>
<td>55</td>
<td>£3.25</td>
<td>£52,900.00</td>
</tr>
<tr>
<td>4 Midfield</td>
<td>54</td>
<td>£3.49</td>
<td>£43,181.82</td>
</tr>
</tbody>
</table>

**7 Manchester United**
- Avg. Points: 62
- Avg. Salary (wk): £79,423.08
- # Players: 26

<table>
<thead>
<tr>
<th>Position</th>
<th>Avg. Points</th>
<th>Avg. Value (m)</th>
<th>Avg. Salary (wk)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 Attack</td>
<td>111</td>
<td>£6.28</td>
<td>£166,250.00</td>
</tr>
<tr>
<td>5 Defense</td>
<td>59</td>
<td>£3.83</td>
<td>£61,666.67</td>
</tr>
<tr>
<td>6 Goalie</td>
<td>55</td>
<td>£3.50</td>
<td>£55,000.00</td>
</tr>
<tr>
<td>7 Midfield</td>
<td>51</td>
<td>£3.98</td>
<td>£66,818.18</td>
</tr>
</tbody>
</table>

**8 Southampton**
- Avg. Points: 78
- Avg. Salary (wk): £22,619.05
- # Players: 21

<table>
<thead>
<tr>
<th>Position</th>
<th>Avg. Points</th>
<th>Avg. Value (m)</th>
<th>Avg. Salary (wk)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 Attack</td>
<td>120</td>
<td>£4.37</td>
<td>£35,000.00</td>
</tr>
<tr>
<td>4 Defense</td>
<td>84</td>
<td>£3.00</td>
<td>£20,416.67</td>
</tr>
<tr>
<td>5 Goalie</td>
<td>43</td>
<td>£2.92</td>
<td>£23,333.33</td>
</tr>
<tr>
<td>6 Midfield</td>
<td>67</td>
<td>£3.09</td>
<td>£19,722.22</td>
</tr>
</tbody>
</table>

**9 Stoke City**
- Avg. Points: 59
- Avg. Salary (wk): £34,130.48
- # Players: 23
What is a Data Map Report?

A data map report breaks down end topics by grouped topics. The map shows the results of the calculations graphically, while the report shows the results of the calculations in tables in Excel. This allows you to use map calculations in other Excel formulas.

Create and View the Data Map

To view a data map report, you must first create the data map. Refer to the What is a Data map and how do I create a Data Map? article to learn how to create the data map. Here is the resulting data map of the Sales by Country.xlsx example file. expanded so that you can see one of the end tables.

Select Data Map Report

Starting from the worksheet with the map, select Create Report from the Data Map dropdown on the BigPicture ribbon.
Save as pdf?

Besides creating the report, you have the option of saving it as a pdf file.

View the data map report

This creates a report - a set of tables - on a new worksheet.

View the summary data

The top of the report shows the rollup calculations. In this case, there is a separate table for each year.
<table>
<thead>
<tr>
<th>Year</th>
<th>Region</th>
<th>Category</th>
<th>Total Units Sold</th>
<th>Total Profit (in $)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2011</td>
<td>Asia</td>
<td>Hair Care</td>
<td>314385</td>
<td>$294,464.21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Oral Care</td>
<td>97905</td>
<td>$162,007.28</td>
</tr>
<tr>
<td></td>
<td>EU</td>
<td>Hair Care</td>
<td>216480</td>
<td>$132,456.93</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Oral Care</td>
<td>73511</td>
<td>$178,901.22</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>163090</td>
<td>$149,370.42</td>
</tr>
<tr>
<td></td>
<td>Latin America</td>
<td>Hair Care</td>
<td>115276</td>
<td>$89,915.93</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Oral Care</td>
<td>34178</td>
<td>$47,577.57</td>
</tr>
<tr>
<td></td>
<td>North America</td>
<td>Hair Care</td>
<td>424151</td>
<td>$454,319.89</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Oral Care</td>
<td>81098</td>
<td>$42,338.36</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>133252</td>
<td>$249,742.95</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>290899</td>
<td>$204,576.93</td>
</tr>
</tbody>
</table>

View detailed calculations

Any of the hyperlinks in the summary report takes you to a detailed table such as the following for Hair Care in Asia in 2011. The link at the top right takes you back to the summary section.
View formulas

Each of the cells in the report contains a formula. The meaning of this formula isn't important. The important part is that the formula retains a link to the underlying data set. Therefore, if the data change, the data map and the data map report update automatically.
### Hair Care/Asia/Year / 2011

<table>
<thead>
<tr>
<th>Country</th>
<th>Units Sold</th>
<th>Profit (in $)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>19311</td>
<td>$36,675.83</td>
</tr>
<tr>
<td>China</td>
<td>41174</td>
<td>$57,883.15</td>
</tr>
<tr>
<td>Japan</td>
<td>37420</td>
<td>$67,448.30</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Product</th>
<th>Units Sold</th>
<th>Profit (in $)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gel for Men</td>
<td>15343</td>
<td>$26,594.60</td>
</tr>
<tr>
<td>Gel for Men Pro</td>
<td>13910</td>
<td>$27,452.20</td>
</tr>
<tr>
<td>Gel for Women</td>
<td>33666</td>
<td>$54,636.16</td>
</tr>
<tr>
<td>Gel for Women Pro</td>
<td>32986</td>
<td>$55,324.32</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Country</th>
<th>Product</th>
<th>Units Sold</th>
<th>Profit (in $)</th>
</tr>
</thead>
<tbody>
<tr>
<td>China</td>
<td>Gel for Men</td>
<td>6142</td>
<td>$9,059.45</td>
</tr>
<tr>
<td>Japan</td>
<td>Gel for Men</td>
<td>5771</td>
<td>$10,791.77</td>
</tr>
<tr>
<td>Australia</td>
<td>Gel for Men</td>
<td>3430</td>
<td>$11,472.34</td>
</tr>
<tr>
<td>China</td>
<td>Gel for Women</td>
<td>14175</td>
<td>$19,496.63</td>
</tr>
<tr>
<td>Japan</td>
<td>Gel for Women</td>
<td>12757</td>
<td>$22,578.89</td>
</tr>
<tr>
<td>Australia</td>
<td>Gel for Women</td>
<td>6734</td>
<td>$12,765.64</td>
</tr>
<tr>
<td>China</td>
<td>Gel for Men Pro</td>
<td>6547</td>
<td>$9,656.83</td>
</tr>
<tr>
<td>Japan</td>
<td>Gel for Men Pro</td>
<td>6378</td>
<td>$11,926.88</td>
</tr>
<tr>
<td>Australia</td>
<td>Gel for Men Pro</td>
<td>2985</td>
<td>$5,868.51</td>
</tr>
<tr>
<td>China</td>
<td>Gel for Women Pro</td>
<td>14310</td>
<td>$19,676.25</td>
</tr>
<tr>
<td>Japan</td>
<td>Gel for Women Pro</td>
<td>12514</td>
<td>$22,148.78</td>
</tr>
<tr>
<td>Australia</td>
<td>Gel for Women Pro</td>
<td>6162</td>
<td>$11,498.29</td>
</tr>
</tbody>
</table>
What are Data Map Report defaults?

These options are designed for large data maps where you want to "get it right the first time." They can save you a lot of repetitive work.

Create the data map

Create the data map in the usual way, as instructed in the other Data Map help topics.

Select Report Defaults

Select Report Options>Defaults from the Data Map dropdown list.
Select defaults

There are basically two options. First, you can select any of the topics in the end topic tables to sort on, and you can select ascending or descending order. Second, if you have requested a PDF report, you can select the number of tables per page, either Auto or One.

View end tables

Here is a typical end table, where the default was changed to sorting on profit in descending order. If this wasn't the original default and you didn't have the Report Defaults option, you would have to double-click the Profit column in each of the end tables to get this sort order. In other words, the Report Defaults option saves you a lot of repetitive work.
View data map report

If you create a data map report, as explained in the corresponding help topic, the end table sections of the report are also sorted in the selected default sort order. In the example shown here, the sort order was changed to descending on items sold. In addition, if you go back to the map and change the report defaults, as in the previous step, the sort order will automatically change in these report tables as well.

<table>
<thead>
<tr>
<th>Country</th>
<th>Units Sold</th>
<th>Profit (in $)</th>
</tr>
</thead>
<tbody>
<tr>
<td>China</td>
<td>93859</td>
<td>$49,230.32</td>
</tr>
<tr>
<td>Japan</td>
<td>81602</td>
<td>$54,143.67</td>
</tr>
<tr>
<td>Australia</td>
<td>41019</td>
<td>$29,082.95</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Product</th>
<th>Units Sold</th>
<th>Profit (in $)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mouthwash Pro</td>
<td>75634</td>
<td>$30,554.42</td>
</tr>
<tr>
<td>Mouthwash</td>
<td>66930</td>
<td>$54,031.53</td>
</tr>
<tr>
<td>Whitening Toothpaste</td>
<td>37497</td>
<td>$32,169.97</td>
</tr>
<tr>
<td>Whitening Toothpaste Pro</td>
<td>36419</td>
<td>$15,701.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Country</th>
<th>Product</th>
<th>Units Sold</th>
<th>Profit (in $)</th>
</tr>
</thead>
<tbody>
<tr>
<td>China</td>
<td>Mouthwash Pro</td>
<td>32805</td>
<td>$11,276.72</td>
</tr>
<tr>
<td>China</td>
<td>Mouthwash</td>
<td>29463</td>
<td>$20,255.81</td>
</tr>
<tr>
<td>Japan</td>
<td>Mouthwash Pro</td>
<td>29251</td>
<td>$12,943.57</td>
</tr>
<tr>
<td>Japan</td>
<td>Mouthwash</td>
<td>24604</td>
<td>$21,774.54</td>
</tr>
<tr>
<td>China</td>
<td>Whitening Toothpaste</td>
<td>16403</td>
<td>$12,097.21</td>
</tr>
<tr>
<td>China</td>
<td>Whitening Toothpaste Pro</td>
<td>15188</td>
<td>$5,600.58</td>
</tr>
<tr>
<td>Japan</td>
<td>Whitening Toothpaste Pro</td>
<td>13942</td>
<td>$6,517.89</td>
</tr>
<tr>
<td>Japan</td>
<td>Whitening Toothpaste</td>
<td>13805</td>
<td>$12,907.68</td>
</tr>
<tr>
<td>Australia</td>
<td>Mouthwash Pro</td>
<td>13578</td>
<td>$6,334.14</td>
</tr>
<tr>
<td>Australia</td>
<td>Mouthwash</td>
<td>12863</td>
<td>$12,001.18</td>
</tr>
<tr>
<td>Australia</td>
<td>Whitening Toothpaste</td>
<td>7289</td>
<td>$7,165.09</td>
</tr>
<tr>
<td>Australia</td>
<td>Whitening Toothpaste Pro</td>
<td>7289</td>
<td>$3,582.54</td>
</tr>
</tbody>
</table>
What are rollup calculations?

Rollup calculations produce summary measures in special BigPicture maps, including data maps, linked maps, and org charts. Examples are provided below.

NOTE: The formatting of the rollup calculation is based on the formatting that is assigned to the cells where the data is being pulled from.

Rollups in data maps

Data set for the map

Here is a typical data set for a data map, where each row includes sales information for some product in some country in some year.

Select grouped topics

There will be three levels of grouping, first by year, then by region, and then by (product) category.
Select end topics, including the desired rollup calculations

To add rollup calculations throughout your map, click on the box in the 'Rollup to Grouped Topics?' column for each variable (column of data) that you would like to have calculated. (See #1) In this example two numeric columns (Profit and Units Sold) will have calculations added and included in rollups. Note that Units Sold will have three calculations and Profit will have one.

For example, the map will show total profit for the entire data set, total profit for 2011, total profit for North America in 2011, and total profit from sales of hair care products in North America in 2011. As well as Total, Average and Standard Deviation of Units Sold because we chose Units Sold with three different calculations. (See #2)

If you check the bottom Rollup End Topic Count option, the grouped topics will show the record counts, i.e., the number of data rows, in each topic. (See #3)

NOTE: If the rollup boxes weren't checked, these totals (and counts) wouldn't appear in the map. However, totals for the two numeric columns would appear in the end tables. For
example, the end table would show total profit for each product separately, and/or for each country separately.

**View rollup results**

Here are some of the rollup calculations. If the rollup boxes weren't checked, the chosen calculations for Units Sold and Profit wouldn't appear in any of these topics.
Rollup End Topic Count

BigPicture has the ability to provide counts in grouped topics. (see #1) These counts can be displayed in the non-detail view and in topics(#2). In the example below, BigPicture provides the counts for each of the groups. You can specify what you would like the label of the counts to be. (#3)
Rollups in linked maps

Data set for the linked map

This data set lists cereal categories (through row 14) and individual cereal products (from row 15 down). The rollup calculations will apply to the categories. Because these categories don't have values for columns C to H, BigPicture requires asterisks in these columns if rollups are desired.

Specify relationships

You first indicate how topics are linked (i.e., related) by clicking on the drop down arrows in the Topic field and the Parent of Topic field.
Specify desired rollup calculations

In this example, it makes sense to request averages for the four numeric columns. For example, the map will show the average price per ounce for all cereal products in the data set and for all Kelloggs products in the data set.

NOTE: You can add the same 'Data for Calculation' option multiple times with different 'Calc Types'. *(See #1)* In this example they will appear as a Topic Note instead of as a Topic Label.
View rollup results

Here is a sample of the category topics. If rollup calculations weren't requested, none of the topics would contain any of these averages.
Rollups for an org chart

Data set for the org chart

This data set not only includes the two columns (second and third) that define the employee-to-supervisor relationships, but it also includes a numeric variable, salary, that can be used for rollup calculations.

Specify relationships

You first indicate the employee-to-supervisor relationships.
Specify desired rollup calculations

In this case, for each employee, the total salary of all direct and indirect subordinates will be shown. Also, by using the keyword Headcount, the number of all direct and indirect subordinates will also be shown. For an employee with no subordinates, only that employee's salary will be shown.
View rollup results

The rollup results are shown in "topic notes" indicated by summation signs. A few have been opened here. For example, Loretta Smith supervises 11 employees, directly or indirectly, and their total salary is $1,142,500. On the other hand, Harold Cross supervises no one, and his salary is $64,600.
Linked Maps

What is a Linked Map and how do I create a Linked Map?

A linked map is essentially an organizational chart in a different context. It is defined in terms of parent-child relationships stored in two columns of a data set.

You can Ctrl+click the following link to watch a video about linked maps: http://www.palisade.com/BigPicture/Intro/EN/LinkedMaps/

Create a data set with parent-child relationships

Like the data set for an organizational chart, where two columns specify the employee to supervisor relationships, the data set for a linked map should specify parent-child relationships. Two typical examples are shown below.
Example with linked columns only

The topics for this example are the aircraft characteristics in column A. These are the children, and their parents are in column B. These are the only two columns in the data set. (This is from one of the example spreadsheets under BigPicture Help.) The Aircraft topic in cell A3 is the root topic; it has no parent. Like with an org chart, there is only one root topic. In the linked map, the Method of Lift, Propulsion, and Use topics will emanate from the Aircraft topic, Aerodynes and Aerostat will emanate from Method of Lift, and so on.

<table>
<thead>
<tr>
<th>Aircraft Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic Name</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>11</td>
</tr>
<tr>
<td>12</td>
</tr>
<tr>
<td>13</td>
</tr>
<tr>
<td>14</td>
</tr>
<tr>
<td>15</td>
</tr>
<tr>
<td>16</td>
</tr>
<tr>
<td>17</td>
</tr>
<tr>
<td>18</td>
</tr>
<tr>
<td>19</td>
</tr>
<tr>
<td>20</td>
</tr>
<tr>
<td>21</td>
</tr>
<tr>
<td>22</td>
</tr>
</tbody>
</table>

Example with other columns

The topics for this example are the cereal categories or individual cereal products in column A. (This is also from one of the example spreadsheets under BigPicture Help.) These are the children, and the parents are in column B. This is an ideal setup for a linked map, where there is a hierarchy from categories down to individual products. Other data are listed in
columns C to F, but these make sense only for individual cereal products, not for categories. Because this data set will be used to illustrate rollup calculations in linked maps, such as average calories per serving for all Kellogg's cereals, BigPicture requires asterisks, not blanks, in the category rows.

Create pictures of topics

If you want the linked map to show pictures of the topics, you can create picture files of the topics and store them in a folder of your choice. The names of these picture files should match the text in some column of the data set. In this case, the cereal data will be used for illustration. Then it makes sense to have a picture for each cereal brand and for each individual cereal product, and to match the picture names with the topics in column A of the data set. For example, names of typical picture files are Kelloggs.jpg and Corn Flakes.jpg (or some other graphics file extension).

Fill in the Linked Map dialog box

Click the Linked Map item on the BigPicture ribbon to bring up the tabbed Linked Map dialog box. Fill in the dialog box as discussed in the following steps. The Linked Map - Cereal.xlsx example file is used in the following steps.
Definition tab

The Definition tab is the most important. Here, you specify the data range, the two columns that specify the child-parent relationship, and any information you want to show in each topic.

Pictures tab

To include pictures, check the Add Pictures for Each Topic option, and then select the folder where the picture files are stored and the field that matches the names of the picture files.
Markers and Tags tab

Markers and Tags are optional. They allow you to show extra information about each topic at a glance. In the example map below, we have added a *Descriptions* column in our data and linked it to a Note Marker.

To have the descriptions appear in a Note Marker:

- Check the box for **Add Markers or Tags to Each Topic** *(See #1)*
- Click on the blank box in row 1 of the Linked Map dialog box
- Choose the name of the column that you would like BigPicture to refer to. For this example, the column name is *Descriptions*. *(See #2)*
- Select Note from the dropdown menu in the Marker or Tag Type column. *(See #3)*

For each cereal brand and product, the description that appears in the spreadsheet column under the *Description* heading will be included in a Note marker to the bottom right of the Topic. *(See #3)*
There are a variety of marker types available in BigPicture. In the Marker or Tag Type drop down, the first two Markers are Note markers and Hyperlink Markers, both of which can refer to a column that has customized text. When working with the other options such as All Countries, Number, Smiley, etc. the column of data that it is referring to MUST have matching names to the names that are included in those particular lists. For example, for the Smiley Marker list the only options are 'Happy', 'Sad', 'Angry' and 'Frustrated'. Which means that there would have to be a column in your data set that has the words 'Happy', 'Sad', 'Angry' and 'Frustrated'. (See #4)

To know what names are associated with what marker, when you are on a page that has a map on it, click on the Markers icon in the ribbon then choose Manage Markers. (See #5) Choose the list that you would like to use and the Manager Markers dialog will show you the Marker Names associated with that particular list (See #4). This shows you the options under the 'Smiley' list. If you would like to add your own markers, view the article Add your own Marker List.

Tags can be found by scrolling down the dropdown menu. (See #6) Tags behave in the same way as Markers (See #7), however instead of placing an icon to the bottom right of the Topic, you can set your markers to have specific colors and formatting associated with them that will automatically format the Topic accordingly. In addition, it can also add a small text box that is placed on top of the Topic. To learn more about Tags view the article What are Tags and how do I Use them?
Calculations tab

Calculations are also optional. They let you show rollup (summary) information about topics. The results of the calculations appear either in the topics themselves (if you choose Topic Label in the Display In column) or below the topics in Notes with summation signs (if you choose Topic Note). In this example, the topic label will include the averages indicated for all of the grouped options and the individual cereal product will have just its own data.

*NOTE: The Maximum number of Calculation Topic LABELS is 4, after you have reached 4 Topic Labels, the remainder of calculations will be displayed in Topic Notes.*
Display tab

The Display tab's default settings usually suffice, but you can change them to suit your taste. In this example, each level of the map will be colored differently, the linked map will be placed on a new worksheet in the same workbook as the data, the chart orientation will be from left to right (as opposed to top-down), and individual cereals will be stacked vertically (the only option when orientation is left to right) - when dealing with a Top Down map.
Check Data button

BigPicture checks your data sets to find and correct capitalization differences, spacing issues, some inadvertent misspellings, etc. that would keep your Linked Maps from being generated properly. BigPicture matches entries in columns used for grouped topics, markers, supervisor names etc. when creating Linked Maps. Small differences can cause entries from not being matched properly.

When creating a Linked Map for the first time, it is recommended to click on the Check Data button to make sure that your data is set up properly. For any subsequent linked maps that you make with that same data, it will not be necessary to click Check Data unless the underlying data has changed.
Create the linked map

When you click the Create Map button, BigPicture creates the linked map and performs any requested calculations. By default, the map shows the root and the next level of topics.
Expand (or collapse) any section of the map

You can click any of the green expand buttons to follow the map structure to the right of a topic. You can then click any of the red collapse buttons to collapse any branches of your map. If the red collapse icon is not visible, place your cursor over the topic that has the branch emanating out from it and bring the cursor towards the edge of the topic where the branch comes out. The red collapse marker will appear. (See #1)
View calculations in topic notes

If you chose to display any calculations in topic notes, as opposed to topic labels, you can click the summation sign notes to see the results.
View information from markers

If there are any markers, such as Notes with extra information on the cereals, click on the Note icon to see the extra information.
Modifying the map

If you want a different map based on the same data set, you can go back into the Linked Map dialog and change the settings. For example, you may want to add a different Marker or display a different summary statistic. When you click on the Create Map button (See #1), you will be asked whether you want to overwrite the current map or create a new map (on a new worksheet). (See #2) You can choose either option.

If you know this ahead of time that you would like to replace the map, you can click on the Update Map button (See #3) instead of the Create Map option. This will eliminate the step where the warning dialog appears. It will automatically choose to overwrite the existing map.
What is a Linked Map Report?

A linked map report breaks down all of your rollup information in a tabular format. The map shows the results of the calculations graphically, while the report shows the results of the calculations in tables in Excel. This allows you to use map calculations in other Excel formulas.

Create and View the Linked Map

To view a linked map report, you must first create the linked map. Refer to the What is a Linked map and how do I create a Linked Map? article to learn how to create the linked map. Here is the resulting linked map of the Linked Map - Cereals.xlsx example file expanded so that you can see the end topics of Post brand cereal.

Select Linked Map Report

Starting from the worksheet with the map, select Create Report from the Linked Map dropdown on the BigPicture ribbon.
Save as pdf?

Besides creating the report, you have the option of saving it as a pdf file.

View the data map report

This creates a report on a new worksheet. The report shows the rollup calculations (See #1) in addition to the information for each type of cereal. If you click on the "group" linked (i.e. Kellogg's - See #2) it will expand/collapse the individual cereals that contribute to that group.
<table>
<thead>
<tr>
<th>Topic</th>
<th>Avg. Price per Ounce</th>
<th>Avg. Calories</th>
<th>Avg. Sodium</th>
<th>Avg. Sugar</th>
<th>Price per Ounce</th>
<th>Calories</th>
<th>Sodium</th>
<th>Sugar</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Cereals</td>
<td>$0.25</td>
<td>128.3</td>
<td>146.7</td>
<td>8.1</td>
<td>$0.25</td>
<td>128.3</td>
<td>146.7</td>
<td>8.1</td>
</tr>
<tr>
<td>Kellog's</td>
<td>$0.20</td>
<td>106.4</td>
<td>150.8</td>
<td>8.7</td>
<td>$0.20</td>
<td>106.4</td>
<td>150.8</td>
<td>8.7</td>
</tr>
<tr>
<td>Kellog's Kids</td>
<td>$0.20</td>
<td>110.0</td>
<td>140.0</td>
<td>11.3</td>
<td>$0.20</td>
<td>110.0</td>
<td>140.0</td>
<td>11.3</td>
</tr>
<tr>
<td>Kellog's Adults</td>
<td>$0.19</td>
<td>104.0</td>
<td>158.0</td>
<td>7.0</td>
<td>$0.19</td>
<td>104.0</td>
<td>158.0</td>
<td>7.0</td>
</tr>
<tr>
<td>Post</td>
<td>$0.36</td>
<td>160.0</td>
<td>147.3</td>
<td>11.1</td>
<td>$0.36</td>
<td>160.0</td>
<td>147.3</td>
<td>11.1</td>
</tr>
<tr>
<td>Post Kids</td>
<td>$0.46</td>
<td>110.0</td>
<td>70.0</td>
<td>13.0</td>
<td>$0.46</td>
<td>110.0</td>
<td>70.0</td>
<td>13.0</td>
</tr>
<tr>
<td>Golden Crisp</td>
<td>$0.43</td>
<td>100.0</td>
<td>25.0</td>
<td>14.0</td>
<td>$0.43</td>
<td>100.0</td>
<td>25.0</td>
<td>14.0</td>
</tr>
<tr>
<td>Waffle Crisp</td>
<td>$0.49</td>
<td>120.0</td>
<td>115.0</td>
<td>12.0</td>
<td>$0.49</td>
<td>120.0</td>
<td>115.0</td>
<td>12.0</td>
</tr>
<tr>
<td>Post Adults</td>
<td>$0.29</td>
<td>190.0</td>
<td>193.8</td>
<td>10.0</td>
<td>$0.29</td>
<td>190.0</td>
<td>193.8</td>
<td>10.0</td>
</tr>
<tr>
<td>Great Grains</td>
<td>$0.20</td>
<td>210.0</td>
<td>135.0</td>
<td>13.0</td>
<td>$0.20</td>
<td>210.0</td>
<td>135.0</td>
<td>13.0</td>
</tr>
</tbody>
</table>
Tell me more about possible calculations in a Linked Map

A linked map can not only show the relationships between topics, but it can also show rollup calculations.

Data set for the linked map

This data set lists cereal categories (through row 14) and individual cereal products (from row 15 down). The rollup calculations will apply to the categories. Because these categories don't have values for columns C to H, BigPicture requires asterisks in these columns if rollups are desired.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Topic</td>
<td>Parent Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>All Cereals</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Kelloggs</td>
<td>All Cereals</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Post</td>
<td>All Cereals</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>General Mills</td>
<td>All Cereals</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Quaker Oats</td>
<td>All Cereals</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Kelloggs Kids</td>
<td>Kelloggs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Post Kids</td>
<td>Post</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>General Mills Kids</td>
<td>General Mills</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Quaker Oats Kids</td>
<td>Quaker Oats</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Kelloggs Adults</td>
<td>Kelloggs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Post Adults</td>
<td>Post</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>General Mills Adults</td>
<td>General Mills</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Quaker Oats Adults</td>
<td>Quaker Oats</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Specify relationships

You first indicate how topics are linked (i.e., related).
Specify desired rollup calculations

In this example, it makes sense to request averages for the four numeric columns. For example, the map will show the average price per ounce for all cereal products in the data set and for all Kelloggs products in the data set.

*NOTE: The Calc Depth for Linked Maps will automatically be set to All Below.*
Specify types of summaries

Under Calc Type, you can specify sums (totals), averages, minimums, or maximums.
Specify display type

Under Display In, you can specify a Topic Note or a Topic Label. A Topic Note appears as a note below the topic with a summation sign, and a Topic Label includes the summary information in the topic's label.
View rollup results

Here is a sample of the category topics, where each of the average rollups is shown as a Topic Label and the Min and Max for sugar is shown as a Topic Note.
Org Charts

How do I create an Org Chart?

You can Ctrl+click the following link to watch a video about org charts:

http://www.palisade.com/BigPicture/Intro/EN/OrgCharts/

Structure the data correctly

The data set should, at a minimum, include employee names and two columns that specify employee-supervisor relationships. In this example, columns B and C play this role. (This data set is from one of the example spreadsheets under BigPicture Help.) Each employee has a title and a supervisor, with the exception of the organization leader, who has no supervisor (the organization leader is the root topic in the chart). Of course, the supervisor also has a title. For example, you could search for Managing Director - West in column B to find the name of Amanda Nelson's supervisor. The data set can have other information about employees as well.

Create pictures of employees

If you want the org chart to show pictures of the employees, you can create picture files of the employees and store them in a folder of your choice. The names of these picture files should match the text in some column, almost always the employee name column. Then the name of a typical picture file is Amanda Nelson.jpg (or some other graphics file extension).
Fill in the Org Chart dialog box

Click the Org Chart item on the BigPicture ribbon to bring up the tabbed Org Chart dialog box. Then fill it in as discussed in the following steps.

Definition tab

The Definition tab is the most important. Here, you specify the data range, the two columns that define the employee-supervisor relationships, and any information you want to show in each employee's topic.
Pictures tab

To include pictures, check the Add Pictures option, and then select the folder where the picture files are stored and the field that matches the names of the picture files.

Markers and Tags tab

Markers are optional. They allow you to show extra information about each employee below the employee's topic. In this example, the employee's performance rating will be shown in a number icon, and the employee's annual review summary will be shown in a note. There are actually many marker types available, which you can choose from a dropdown list.
Markers and Tags tab

Markers and Tags are optional. They allow you to show extra information about each topic at a glance. In the example map below, we have added a Number Marker and a Note Marker to coincide with the *Employee Performance Rank* and the *Annual Review Summary* columns.

To have the *Employee Performance Rank* appear as Number markers:

- Check the box for **Add Markers or Tags to Each Employee's Topic** *(See #1)*
- Click on the blank box in row 1 of the Org Chart dialog box
- Choose the name of the column that you would like BigPicture to refer to. For this example, the column name is *Employee Performance Rank*. *(See #2)*
- Select Number from the dropdown menu in the Marker or Tag Type column. *(See #3)*

Now, to have the *Annual Review Summary* descriptions appear in a Note Marker:
● Click on the blank box in row 2 of the Org Chart dialog box

● Choose the name of the column that you would like BigPicture to refer to. For this example, the column name is *Annual Review Summary*. *(See #4)*

● Select Note from the dropdown menu in the Marker or Tag Type column. *(See #5)*

For each employee the description that appears in the spreadsheet column under the *Annual Review Summary* heading will be included in a Note marker to the bottom right of the Topic along with a number icon that will reflect the *Employee Performance Rank*. *(See #6)*

We just explored 2 marker types. There are a variety of marker types available in BigPicture. In the Marker or Tag Type drop down, the first two Markers are Note markers and Hyperlink Markers, both of which can refer to a column that has customized text. When working with the other options such as All Countries, Number, Smiley, etc. the column of data that it is referring to MUST have matching names to the names that are included in those particular lists. For example, for our Number list the only options are 0,1,2,3,4,5,6,7,8,9,10 - Which means that the column that we are referring to (in this example - *Employee Performance Rank*) can only have those values.

To know what names are associated with what marker, when you are on a page that has a map on it, click on the Markers icon in the ribbon then choose Manage Markers. *(See #7)* Choose the list that you would like to use and the Manager Markers dialog will show you the Marker Names associated with that particular list *(See #8)*. This shows you the options under the 'Number' list. If you would like to add your own markers, view the article *Add your own Marker List.*

Tags can be found by scrolling down the dropdown menu. *(See #9)* Tags behave in the same way as Markers *(See #10)*, however instead of placing an icon to the bottom right of the Topic, you can set your markers to have specific colors and formatting associated with them that will automatically format the Topic accordingly. In addition, it can also add a small text box that is placed on top of the Topic. To learn more about Tags view the article *What are Tags and how do I Use them?*
Calculations tab

Calculations are also optional. They let you show rollup (summary) information about each employee who supervises other employees, either directly or indirectly. The results of the calculations appear below the employee topics in text boxes with summation signs. The keyword Headcount is used to produce counts of employees reporting to a supervisor. Numeric data from other columns can also be rolled up for each supervisor. The choices here will show the number and total salary of all employees who report directly or indirectly to a supervisor. A text box will also be included for each employee who doesn't supervise anyone, but it will just show that employee's salary.
There are actually dropdown lists next to Calc Type, Calc Depth, and Display In. For example, Calc Depth can be All Below or Direct Reports. You can experiment with the various options.

Filter tab

A filter is also optional. It lets you include only a subset of all employees in the chart. For example, if a supervisor is located in New York and all of the people who report to him, directly or indirectly, are also located in New York, the resulting chart will just show his section of the organization.

To add a filter:

- Check the Pre-filter Employees Included in Chart (See #1)
- Click on the dropdown arrow to see a list of available Columns to filter on. (See #2) For this example we will choose Location. (See #3)
Click on the Excel Selection icon (See #4) to select the value from your data that you would like to filter on. For this example we click on one of the New York entries. (You can add multiple Locations by SHIFT+Clicking when making your selection.)

Click OK on the Filter Data dialog. (See #5) It will automatically convert your cell selection into the actual content that you would like to filter on in the **Include Employees with Values** field. (See #6)

Click the **Create Chart** button (See #7)

The resulting Org Chart only has New York employees. (See #8)

To remove a filter, you simply uncheck the Pre-Filter box. (See #1)
Display tab
The Display tab's default settings usually suffice, but you can change them to suit your taste. In this example, each level of the organization will be colored differently, the org chart will be placed on a new worksheet in the same workbook as the data, the chart orientation will be from the top down (as opposed to left-to-right), and employees that do not supervise anyone will be displayed vertically, not horizontally.
Check Data Button

BigPicture checks your data sets to find and correct capitalization differences, spacing issues, some inadvertent misspellings, etc. that would keep your Organizational Charts from being generated properly. BigPicture matches entries in columns used for grouped topics, markers, supervisor names etc. when creating Organizational Charts. Small differences can cause entries from not being matched properly.

When creating an Organizational Chart for the first time, it is recommended to click on the Check Data button to make sure that your data is set up properly. For any subsequent organizational charts that you make with that same data, it will not be necessary to click Check Data unless the underlying data has changed.
Create org chart

When you click the Create Chart button, BigPicture creates the org chart and performs any requested calculations. By default, the chart shows the root (CEO) and the first level of supervisors.

*NOTE: The example shown here does not contain a filter.*
Expand (or collapse) any section of the chart

You can click any of the green expand buttons to follow the org structure beneath a supervisor. (See #1) You can then click any of the red collapse buttons to collapse any part of this. (See #2)
View calculations

You can click any of the buttons with summation signs to see results of calculations. Here are the results for Loretta Smith, for one of her subordinates, Amanda Nelson, and for an employee, Harold Cross, whom supervises no one. Note that each person's own salary is listed, along with any rollup summaries.
View information from markers

You can click any of the other "note" markers to see extra information. Here is the annual review summary for June Peters.

Modifying the chart

If you would like a different org chart based on the same data set, you can go back into the Org Chart dialog and change the settings. For example, you may want to add a different Marker or display a different summary statistic, or maybe someone received a promotion and the hierarchy of your organization has changed. After you make your changes to the data and/or to the org chart settings, click on the Create Chart button (See #1), you will be asked whether you want to overwrite the current chart or create a new chart (on a new worksheet). (See #2) You can choose either option.

If you are only changing the data values associated with the chart such as a name change, salary change, etc., BigPicture does the work for you. When you make any changes to the underlying data values, there is no need to create a new chart, the data changes will be reflected in the chart instantly.
An org chart that is linked to this data is open.
Select Yes to overwrite this chart, No to create a new chart.
Tell me more about possible calculations in an Org Chart

You might need only a basic org chart, where the structure of the organization is laid out. However, BigPicture also allows you to create rollup calculations in an org chart. This is illustrated in the main help topic on org charts, but it is important enough to repeat here.

Data set for the org chart

This data set not only includes the two columns (second and third) that define the employee-to-supervisor relationships, but it also includes a numeric variable, salary, that can be used for rollup calculations.

<table>
<thead>
<tr>
<th>Employee</th>
<th>Employee Title</th>
<th>Supervisor Title</th>
<th>Phone</th>
<th>Location</th>
<th>Salary</th>
<th>Rank (1-10)</th>
<th>Annual Bonus/Tertiary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Amanda Nelson</td>
<td>Director - Sales / West</td>
<td>415/303-2000 x202</td>
<td>San Francisco</td>
<td>$100,200</td>
<td>7</td>
<td>Amanda understands how to sell</td>
</tr>
<tr>
<td>2</td>
<td>Brett Petersen</td>
<td>Developer</td>
<td>212/303-2000 x141</td>
<td>New York</td>
<td>$84,300</td>
<td>8</td>
<td>Brett is a consistent worker</td>
</tr>
<tr>
<td>3</td>
<td>Cynthia Williams</td>
<td>Accounting Assistant</td>
<td>212/303-2000 x235</td>
<td>New York</td>
<td>$92,450</td>
<td>6</td>
<td>Cynthia has a good work attitude</td>
</tr>
<tr>
<td>4</td>
<td>David Drake</td>
<td>Developer</td>
<td>212/305-2000 x137</td>
<td>New York</td>
<td>$89,950</td>
<td>9</td>
<td>David works well under pressure</td>
</tr>
<tr>
<td>5</td>
<td>David Kim</td>
<td>Sales Assistant</td>
<td>212/200-2000 x117</td>
<td>New York</td>
<td>$43,500</td>
<td>6</td>
<td>David is good at qualifying sales</td>
</tr>
<tr>
<td>6</td>
<td>Debbie Anderson</td>
<td>Tech Support Specialist</td>
<td>212/200-2000 x139</td>
<td>Dallas</td>
<td>$62,550</td>
<td>7</td>
<td>Debbie is courteous and knowledgable</td>
</tr>
<tr>
<td>7</td>
<td>Diana Miller</td>
<td>Sales Account Manager</td>
<td>415/302-2000 x205</td>
<td>San Francisco</td>
<td>$98,100</td>
<td>10</td>
<td>Diana is consistently a top performer</td>
</tr>
<tr>
<td>8</td>
<td>Douglas Mitchell</td>
<td>Tech Support Specialist</td>
<td>212/305-2000 x133</td>
<td>New York</td>
<td>$87,200</td>
<td>8</td>
<td>Douglas has broad product knowledge</td>
</tr>
<tr>
<td>9</td>
<td>Elaine Ross</td>
<td>Receptionist</td>
<td>212/305-2000 x115</td>
<td>New York</td>
<td>$80,000</td>
<td>8</td>
<td>Elaine is very dependable</td>
</tr>
<tr>
<td>10</td>
<td>Elizabeth Davis</td>
<td>Web Designer</td>
<td>212/305-2000 x130</td>
<td>New York</td>
<td>$71,600</td>
<td>8</td>
<td>Elizabeth is very dependable a</td>
</tr>
<tr>
<td>11</td>
<td>Erin Tate</td>
<td>Sales Account Manager</td>
<td>415/305-2000 x204</td>
<td>San Francisco</td>
<td>$84,100</td>
<td>7</td>
<td>Erin is adept at establishing goals</td>
</tr>
</tbody>
</table>

Specify relationships

You first indicate the employee-to-supervisor relationships.
Specify desired rollup calculations

In this case, for each employee, the total salary of all direct and indirect subordinates will be shown. Also, by using the keyword Headcount, the number of all direct and indirect subordinates will also be shown. For an employee with no subordinates, only that employee's salary will be shown.

There are several options besides the ones shown here, as explained in the following substeps.
Specify types of summaries

Under Calc Type, you can specify sums (totals), averages, minimums, or maximums.
Specify Calc Depth

Under Calc Depth, you can specify that the rollups should include only direct subordinates or all direct and indirect subordinates.
Specify display type

Under Display In, you can specify a topic note or a topic label. A topic note appears as a note below the topic with a summation sign, and a topic label includes the summary information in the topic's label itself.
View rollup results

The rollup results are shown in "topic notes" indicated by summation signs. A few have been opened here. For example, Loretta Smith supervises 11 employees, directly or indirectly, and their total salary is $1,142,500. On the other hand, Harold Cross supervises no one, and his salary is $64,600.
What is an Org Chart Report?

When you create an org chart in BigPicture, you have the option of creating a corresponding report on a separate worksheet. This is a more tabular presentation of the data, and it is especially useful if the org chart contains calculations, such as the total salary of supervisors and all employees reporting to them. The calculations in this report, as in the chart itself, are linked to the underlying data, so that they change automatically if the data change. If you like, you can also create a pdf of this report.

View the org chart

To create an Org Chart Report, you first have to Create the Org Chart.

Create the report

After you create your Org Chart, make sure the Org Chart sheet is active, then click Org Chart > Create Report and follow the steps below.
PDF option

You can choose whether to save the report as a PDF. In any case, the report will be created on a new worksheet.

View the report

The report appears in a new worksheet and is straightforward. The requested calculations appear in the Supervisor Rollup columns (See #1), one of the markers appears in the column to their left (See #2), and the other marker (the note on the employee's annual review summary) appears in the last column (See #3). Again, this report is live, so if the original data changes, the report will update automatically.
Collapse or expand

For each employee that supervises someone, there is a link on the employee's name that lets you collapse or expand. In the example below, by clicking on James Larson it collapses all of the employees that are under his direct reports, leaving only those that report directly to him showing.

NOTE: In the image above you are able to see Brett Peterson, David Drake and Sandra Wilcox under Patrick Merrill - in addition to Thomas Olsen and William Farnum and their employees. When you click on James Larson (See image below) the report only displays Patrick Merrill, Thomas Olsen and William Farnum. To expand the view to include everyone you can click on James Larson again.
(Optional) Sort on any column

Here is an example where the chart was collapsed so that only the CEO and his direct reports are shown, and they were sorted (using Excel's Z to A button) in decreasing order of head count.

<table>
<thead>
<tr>
<th>Employee</th>
<th>Employee Title</th>
<th>Location</th>
<th>Headcount</th>
<th>Total Salary</th>
<th>Salary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jeffrey Wiggins</td>
<td>CEO &amp; President</td>
<td>New York</td>
<td>64</td>
<td>$5,104,800</td>
<td>$200,000</td>
</tr>
<tr>
<td>James Larson</td>
<td>Director - Software Development</td>
<td>New York</td>
<td>17</td>
<td>$1,228,900</td>
<td>$147,500</td>
</tr>
<tr>
<td>Linda Zimmerman</td>
<td>Vice President - Operations</td>
<td>New York</td>
<td>15</td>
<td>$1,025,800</td>
<td>$164,500</td>
</tr>
<tr>
<td>Loretta Smith</td>
<td>Managing Director - West</td>
<td>San Francisco</td>
<td>10</td>
<td>$789,000</td>
<td>$141,300</td>
</tr>
<tr>
<td>Paul Weisberg</td>
<td>Vice President - Sales &amp; Marketing</td>
<td>New York</td>
<td>9</td>
<td>$784,950</td>
<td>$138,900</td>
</tr>
<tr>
<td>Sam Parker</td>
<td>Managing Director - South</td>
<td>Dallas</td>
<td>8</td>
<td>$550,350</td>
<td>$133,700</td>
</tr>
</tbody>
</table>
Other Collapse/Expand Options

You can also collapse and expand from the Report Options dropdown list. These are "report-wide" options. For example, if there are five levels of employees, one click of Collapse will show only the first four levels of employees, a second click will show only the top three levels, and so on. Then clicks of Expand will reverse the process. The Reset option doesn't undo the collapsing, but it restores the sort order of the report to the original sort order in case you made changes. The other option is to create a PDF of the report. You can do so by selecting Create PDF from the dropdown menu.

Import/Export Options

Can I save a map as a pdf file?

Yes, you can, and it's easy.

Select Export to PDF

With a map open, select the Map to PDF item from the BigPicture Import Export dropdown list. This puts a rectangular outline around the map and opens the "save as" dialog box in the next step.
Save as a pdf file
Select a name and location for the file.

View in Reader or Acrobat
The map automatically opens as a "picture" in your pdf viewer.
Print a zoomed in portion of your PDF

Occasionally you may want to print just a small portion of your map or Org Chart from your PDF. Here are some steps that will help you:

- Open the PDF in Adobe Reader or Adobe Acrobat.


- Drag a rectangle around the area you want to print. (See #1)

- Choose File > Print.

- Make sure that the Selected Graphic option is selected in the Print Range area of the Print dialog box. (See #2)
(Optional) To enlarge the selected text or graphic to fit the sheet of paper, choose Fit To Printable Area from the Page Scaling pop-up menu - (or [Fit] - See #3). **Note:** Enlarging the area reduces the printed resolution.

Click OK or Print.
How do I import MindManager or FreeMind maps into BigPicture?

The BigPicture Converter allows users to import maps from both MindManager and FreeMind. Files supported include those created using MindManager Version 6 (2005) and later - MMAP file types, and FreeMind Version 1 - MM file types. The following steps will walk you through how to import a MindManager MMAP file.

Import a Map

1. Click the Import/Export button in the BigPicture ribbon.

2. Select Import, then Map from MindManager

Note: The same steps can be followed to import a FreeMind map. Simply select Map from FreeMind in the import drop down menu.

Click the Browse button in the 'Import From MindManager' dialog box.

Note: The 'Import From FreeMind' dialog looks the same as the 'Import From MindManager' dialog box below.
Select your existing MMAP file. (or your MM file)

*For this example we will import an existing 'Google-.mmap' file*
View the preview, edit options and click 'Import'

1. For MindManager MMAP files, there is usually a preview of the file to be imported which will be displayed in the preview pane.

2. If you would like to edit the Import options click on the Options tab. *(These options are explained below.)*

3. Once the file is selected, use the Import button to import the file.

View the Imported file

*A new workbook, and BigPicture map will be created using the imported file. You can now make edits using BigPicture.*
Options

Click on the Options Tab to alter various Import Options
Option 1: Use Office Themes for Colors and Fonts

BigPicture utilizes Microsoft Office Themes when creating topics, which allows the user to easily switch between several color and font schemes for their maps. Selecting this option in the BigPicture Converter creates a custom theme based on the fonts and colors of the imported map.

*Note: There are a limited number of colors and fonts associated with a specific theme, so maps that are imported with several colors and/or fonts may not be precisely represented in terms of Office Themes.*
Option 2: Create BigPicture Organization Chart Table

BigPicture allows users to create an Organization Chart from a “linked” table. Selecting this option will create a table that can be used to create a BigPicture Organization Chart. A standard map will also be created when this option is selected.
Option 2 (cont.): Create a BigPicture Organization Chart from the Table

After the chart is created from the imported file, you can create a BigPicture Organization Chart:

1. Go to the *BPConvertOrgChart* worksheet.

2. Click on the **Org Chart** drop down menu in the BigPicture ribbon

3. Choose **Org Chart**…

4. Click on the **Create Chart** button once you have set your other preferences in the Organization Chart dialog box.
Option 3: Generate Log File with Import and Conversion Details

This option creates a log file of the conversion process, providing the user with details of the original map and topic information. This file is named \textit{BigPictureConverterUserLog} and is located in the Windows temporary folder.

Supported Features

The following chart shows the supported features of the products and what they are imported into BigPicture as.
PrecisionTree Feature: View in BigPicture

Although this is not a feature within BigPicture, this is a feature that is worth mentioning for our PrecisionTree users. PrecisionTree is an add-in for Excel that performs decision analysis using decision trees and influence diagrams. Decision trees are quantitative diagrams with nodes and branches representing different possible decision paths and chance events. This helps you identify and calculate the value of all possible alternatives, so you can choose the best option with confidence. PrecisionTree is
available by itself or as part of the DecisionTools Suite, Palisade’s complete risk and decision analysis toolkit.

Our new PrecisionTree/BigPicture feature allows you to take an existing decision tree in PrecisionTree and view it as a BigPicture map. This provides a more interactive and customizable view for the tree and puts it in a format more directly usable for presentations. This helps accomplish BigPicture’s goal of utilizing diagrams and maps to make results more accessible and understandable for decision makers. It is also an example of how BigPicture can integrate with our existing DecisionTools Suite tools. Below you will find a variety of ways that these two tools work seamlessly with one another.

Convert a PrecisionTree Decision Tree into a BigPicture Map

To be able to view/convert a decision tree that is created in PrecisionTree into a BigPicture map you can take the following steps:

- Create a decision tree in PrecisionTree
- Click on the View in BigPicture button in the Precision Tree ribbon (1)
- Select which decision trees you would like to convert and where you would like them displayed (2)
- Click OK (3)
- View and customize your decision tree(s) in BigPicture
BigPicture Map is Directly Linked to PrecisionTree

The BigPicture view of the tree is completely linked to the original tree in PrecisionTree. If you would like to change values or probabilities for nodes (topics) and branches (connectors), you can either change the value in the source tree in PrecisionTree, or you can right-click on a topic and choose “Decision Tree Editor” from the pop up menu.

In the below example, the optimal path updates automatically when the value of the node (topic) “TEST” was changed from -55000 to -555000.

NOTE: The source tree in PrecisionTree is also updated when the "Decision Tree Editor" is used.

If you close the Decision Tree Editor you can redisplay it using the BigPicture right-click menu on the topic that you would like to edit.

NOTE: Only changed values and labels are linked. If you add or delete nodes in PrecisionTree, the map in BigPicture does not update to reflect that - you will have to repeat the process and click on the View in BigPicture option in PrecisionTree to reflect that type of structural change.
Paths Pane for Decision Trees

A new icon titled Paths will appear in your BigPicture ribbon after you have created a decision tree using PrecisionTree and you have chosen to view it in BigPicture.

When you click on the Paths icon in the BigPicture ribbon it will open the Paths Pane and display a list of all of the different paths and their probabilities. You can click on any path in the tree view to have it highlight in the BigPicture map. In this case below, the most likely optimal path is shown.

Click the “Optimal Paths” entry in the tree view to display all optimal paths in the decision tree. You can also sort the list of possible paths by their probability utilizing the Sort functionality located at the bottom of the Path Pane.
Option: Use BigPicture's Collapse/Expand functions

Once converted, you can use the normal BigPicture controls to collapse and expand the tree. The optimal paths through the tree are highlighted.
Option: Choose how you would like your map/diagram arranged

If you would prefer to view your map from a different viewpoint, you can use Arrange Map to display the decision tree from top down, or vice-versa.

Option: Customize your Decision Tree in BigPicture and Export it as a PDF

Once you have converted your decision tree into a BigPicture map, it can then be customized and annotated just like any map in BigPicture. You can add pictures and markers to topics or attach custom shapes as desired to improve the presentation of the tree.

After you have customized it, you can choose to export either the whole tree or a single path as a PDF that can be used in a PowerPoint presentation or report.